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Chapter 1

Introduction

Videoconferencing (also known as Video Chat) takes place when two or more 

people communicate using video and some combination of audio, text, or graphics. 

CU-SeeMe is White Pine’s videoconferencing software for your desktop computer 

featuring color video, audio, chat, and white board communications. You can use 

CU-SeeMe on the Internet or any TCP/IP network for real-time person-to-person or 

group conferencing, broadcasts, and chats. Whether you are an instructor 

conducting a training class, a business manager communicating to a customer, or 

someone wanting to chat with a friend, you will be amazed at the ways CU-SeeMe 

will bring you closer!

In this chapter you will learn where to find information about CU-SeeMe and what 

you need to install your software. You will also get an explanation of CU-SeeMe 

conference types. This is helpful to understand before you begin your first 

videoconference.
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Where to Find Information
You are starting at the right place! With the help of this User Guide, you will be 

videoconferencing in minutes. This book guides you through the process of making 

your first connection, enabling you to see and speak with other people. This book also 

explains some of the most often used features of CU-SeeMe.

This PDF file can be viewed online using Adobe® Acrobat®. If you find that the 

graphics in this book are not clear when viewed online, you can change the zoom 

setting in Acrobat to increase the magnification. This PDF file can also be printed.

In addition to this book, there are other sources of information to help you use and 

enjoy CU-SeeMe:

Online Help
CU-SeeMe comes with online Help, a complete reference tool that includes 

step-by-step procedures and additional information about CU-SeeMe that is not 

covered in this book.

You can get Help in two ways:

◆ You can view the CU-SeeMe Help Contents window by choosing CU-SeeMe 
Help Topics from the Help menu. From the CU-SeeMe Help window you can 
select Help topics for more specific information.

◆ You can also get context-sensitive Help by clicking the Help button found in 
many dialog boxes and message windows. 

Web Pages
See the CU-SeeMe World Wide Web pages (http://www.cuseeme.com) for more 

information about CU-SeeMe, including product updates and technical support.

Other Books
For information on Microsoft® Windows®, consult the Windows user guide provided 

with your version of Windows from Microsoft, Inc. 

Because CU-SeeMe has become so popular around the world, many books have been 

written about it. Here are a few:
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Enhanced CU-SeeMe by Robert Rustici is published by MIS:Press, ISBN 

1-55828-490-7. This book explains the nuts and bolts and etiquette of 

videoconferencing with CU-SeeMe.

The Internet TV with CU-SeeMe by Michael Sattler is published by SAMS/

Macmillian, ISBN 1-57521-006-1. This book provides an 

in-depth look at the freeware version of CU-SeeMe.

Videoconferencing: The Whole Picture by Toby Trowt-Bayard is published by 

Flatiron Press, ISBN 0-936648-48-1. This book, a videoconferencing systems and 

network buyers guide, thoroughly describes all aspects of videoconferencing.
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System Requirements
There are many ways to use CU-SeeMe, depending on the hardware and software you 

have. If you want to send video from your computer you need to have a video camera 

and a video capture card (sometimes referred to as a video digitizer card), or use a 

video camera that does not require a capture card, such as the Connectix QuickCam. 

You can receive video from other users even if you don’t have a video camera or a 

video capture card, however other users will not be able to see you.

You need to make sure you have a sound card installed in your computer in order to 

send and receive audio. 

White Pine maintains a list of recommended video capture cards, sound cards, and 

cameras that work with CU-SeeMe. This list is published online in our Frequently 

Asked Questions (commonly referred to as FAQs) on the World Wide Web at 

http://www.cuseeme.com/support.

Minimum System Requirements
To use CU-SeeMe, you need the minimum requirements listed in the following 

sections.

Computer Requirements:

◆ Windows 95 or Windows NT Version 4.0

◆ Pentium processor, 100 megahertz (MHz) minimum

◆ 16 megabytes (MB) of RAM (24 MB or more recommended)

◆ 10 MB of hard disk space

Network Connections:

◆ TCP/IP (Winsock-compliant), PPP for dial-up connection

◆ 28.8 Kbps modem, Ethernet, or ISDN connection

◆ IP address
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To Send Video:

◆ Digitizer camera (such as Connectix QuickCam)

- or - 

◆ Video camera and video capture card

To Send Audio:

◆ Microphone

◆ 16-bit sound card and drivers

To Receive Audio:

◆ Speakers or headphones

◆ 16-bit sound card and drivers
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CU-SeeMe Assistants
CU-SeeMe includes many Assistants to help you accomplish tasks while using the 

program. Assistants are step-by-step guides that lead you through a process, such as 

creating a Contact Card, creating a Personal Profile, creating a multicast conference, 

and more.

When you have finished installing CU-SeeMe and you run CU-SeeMe for the first 

time, the CU-SeeMe Setup Assistant appears. Follow the steps as it guides you through 

the process of configuring CU-SeeMe for your first videoconference connection. 

Using this Assistant, you will set up your video and audio sources, create 

communication settings based on your network connection, and choose whether to 

share information to make it easier for other people to contact you using CU-SeeMe. 

See “Using the Setup Assistant” on page 2-2 for more information.
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CU-SeeMe Conference Types
When you communicate with someone using CU-SeeMe, your conversation is called 

a conference. A conference can include communication using video, audio, text, and 

graphics. CU-SeeMe allows you to communicate with people using several conference 

types: 

◆ Point-to-Point Conference

◆ Group Conference

◆ Cybercast Conference

◆ Multicast Conference

The following sections will explain the first three conference types, since these are the 

most widely-used conferences. To learn more about multicast conferences, see 

“Multicast Conferences” on page 3-40.

Point-to-Point Conference
A point-to-point conference occurs when one person conferences directly with another 

person. Each person must have a computer running CU-SeeMe. You can be connected 

through the Internet or through a private network such as a local area network (LAN) 

or wide area network (WAN). A point-to-point conference is illustrated in Figure 1-1.

Figure 1-1. A point-to-point conference connects two people
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As an example, suppose you want to videoconference directly with a friend. You would 

need to know that friend’s Internet Protocol (IP) address. You can then use CU-SeeMe 

to call that IP address and conference with your friend, much like you would dial your 

friend’s telephone number if you wanted to connect for a telephone call. Like a 

telephone number, an IP address is a unique numeric identifier except instead of 

identifying your telephone, it identifies your network-connected computer. (If you use 

an online directory service, you can eliminate the need to know an IP address to make 

a call. See “Registering With an Online Directory Service” on page 6-22 for more 

information.)

Group Conference
A group conference provides a collaborative environment where co-workers, students, 

or whole families can participate in a conference. The most common way to participate 

in a group conference is to connect to a computer running conference server software, 

such as the White Pine Reflector. Any video, audio, text, or graphics that you transmit 

is received by the conference server, then transmitted to all others connected to the 

conference. A group conference is illustrated in Figure 1-2. 

Figure 1-2. A conference server connects a group of people in a collaborative environment

A group conference has an IP address or host name that you use to call it, just like a 

point-to-point conference. Some group conferences require a unique conference ID 

number or password to join the conference.
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Cybercast Conference
A cybercast (or one-way conference) is similar to television broadcasting. One 

computer, running conference server software, transmits audio and video to all users 

who connect to it. The individual users can not send video, audio, text, or graphics; 

they can only receive broadcast data. A cybercast conference is illustrated in Figure 

1-3.

Figure 1-3. A cybercast conference is like a TV broadcast for your computer

Some examples of cybercast conferences are NASA-TV that broadcasts video and 

audio about space shuttle missions, teachers who cybercast their lessons to remote 

students, and trade shows that broadcast video and audio of keynote speakers.
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Chapter 2

Making Your First 
Connection

Now that you have installed the CU-SeeMe software and checked to make sure your 

computer has the minimum system requirements (see page 1-4), you are ready to 

connect to your first videoconference. This chapter will guide you step-by-step into 

a videoconference where you will see and send video, talk with other people online, 

and exchange Chat text. Once you have taken the “Quick Start” approach presented 

in this chapter and you have participated in your first videoconference, you will want 

to try using additional features of CU-SeeMe. In subsequent chapters, you will 

discover all the fun and useful ways you can enhance your videoconference 

experience.

Remember, if you need more help, it is available online. See page 1-2 for 

information on using online Help.
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Using the Setup Assistant
The first time you start CU-SeeMe, you will see the CU-SeeMe Setup Assistant. This 

helps you set up your computer and prepares you for your first videoconference. 

When you installed CU-SeeMe, you were given the option of running CU-SeeMe 

immediately after installation. If you chose this option, then the Setup Wizard 

appeared automatically. If you did not choose this option, then you must start 

CU-SeeMe manually. To do this from the Windows desktop, click Start, point to 

Programs, point to CU-SeeMe, then click CU-SeeMe for Windows.

When CU-SeeMe starts, the CU-SeeMe Setup Assistant appears, as shown in Figure 

2-1.

Figure 2-1. The CU-SeeMe Setup Assistant helps you prepare for your first videoconference
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This Assistant guides you through five steps, after which you will be ready for your 

first connection. The first step will enable you to define the personal information that 

you want to share with other CU-SeeMe users. Click Next to proceed. The dialog box 

shown in Figure 2-2 appears.

Figure 2-2. Define information to share with other CU-SeeMe users

The information in this dialog box is optional. Any information you enter here will be 

available to other CU-SeeMe users in a conference. You can enter, change, or delete 

any of this information at a later time. See “Editing a Personal Profile” on page 3-25 

for more information. When you are done entering information, click Next.

Your CU-SeeMe Name
is the name that 
appears when you 
conference with 
others.

Enter your name,
address, and e-mail.
This information
is optional and can
be edited later.
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You are now on step two, as shown in Figure 2-3.

Figure 2-3. You are on step two

Click Next to proceed. The dialog box, shown in Figure 2-4, appears.

Figure 2-4. You can register with an online directory service

You can choose to register and list your name on a Web-based directory services 

server. This will allow other CU-SeeMe users to locate you and connect to you. This 

is optional. (To learn more about registering with Four11 directory service, see 

“Registering With an Online Directory Service” on page 6-22.) When you are done, 

click Next.

Select this to have
your name listed in 
a directory service 
on the Web each time
you are connected

Enter your Four11 
password if you are
already registered

Click here to register
on Four11 directory
service
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You are now on step three, as shown in Figure 2-5.

Figure 2-5. You are on step three

Click Next to proceed. The dialog box, shown in Figure 2-6, appears.

Figure 2-6. Choose your network type

Using the drop-down list, choose your network type. You must choose a network 

configuration type that best matches your network. For example, if you are using a 

modem, select the corresponding modem choice. 

Click the arrow to 
display a list of network
types. Choose the one
that best matches your
configuration.

Click here to modify
your maximum
transmit and receive 
rates.
Chapter 2. Making Your First Connection          2-5



           
Click Customize to modify the maximum rates at which you can transmit and receive 

data. This step is optional. The default settings work best for most users. When you are 

done, click Next.

You are now on step four, as shown in Figure 2-7.

Figure 2-7. You are on step four

Click Next to proceed. The dialog box, shown in Figure 2-8, appears.

Figure 2-8. You can see the video that you will send to others

Click here to select
your video capture
device or to change
your capture settings.
The default settings 
work best for most
users.

Click here to take 
your picture and 
add it to your Contact
Card.
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If you have a camera, you can use this dialog box to test the video image that you will 

be sending to others. This dialog box also displays a Contact Card, which is like a 

business card or a card in a rotary file. It is a convenient way to present and store 

information about a person or place. To learn more about Contact Cards, see “Contact 

Cards” on page 3-11. To learn more about storing information about yourself to send 

to others, see “Creating a Personal Profile” on page 3-22.

Click Take a picture to add your picture to the Contact Card. This is optional. The 

resulting card is shown in Figure 2-9.

Figure 2-9. You can take your picture and add it to your Contact Card

When you are done, click Next.

This Contact Card 
includes your personal
picture.
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You are now on step five, as shown in Figure 2-10.

Figure 2-10. You are on step five

Click Next to proceed. The dialog box, shown in Figure 2-11, appears.

Figure 2-11. You can adjust your microphone and speaker

Use this dialog box to test your microphone and speaker and make audio adjustments.

When you are done, click Next.

Click here to test
your speaker volume

Click here to select
your audio playback
device

Click here to 
select your audio 
recording device

Your microphone
volume is shown 
here

Microphone 
volume control

Speaker volume
control

Your speaker volume
is shown here

Select this if you 
have a full duplex
sound card
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You have now completed the CU-SeeMe Setup Assistant, as shown in Figure 2-12.

Figure 2-12. You are now ready to run CU-SeeMe and get connected

Continue to the next section to make your first connection and begin 

videoconferencing.
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Getting Connected
If you are connecting to the Internet using an Internet Service Provider (ISP), you must 

be dialed into your ISP prior to starting CU-SeeMe.

CU-SeeMe is already set up to connect you to a group conference called the White 

Pine Cafe. This is a virtual cafe where you will meet other people who happen to be 

connected to the White Pine Cafe at the same time. These are real live CU-SeeMe 

users, just like you! 

Are you ready? Let’s begin.

Connecting to the White Pine Cafe
If CU-SeeMe is not already running, you must start the program. To do this from the 

Windows desktop, click Start, point to Programs, point to CU-SeeMe, then click 

CU-SeeMe for Windows. The Quick Start & Tips window appears, as shown in 

Figure 2-13. (If the Quick Start & Tips window does not appear when you start 

CU-SeeMe, go to the Phone Book Help menu and click Quick Start & Tips.)

Figure 2-13. The Quick Start & Tips window helps you make your first connection

Click Visit White Pine. Your computer now dials the Internet Protocol (IP) address 

of the White Pine Cafe. A dialog box will appear, indicating that your computer is 

establishing a connection to the White Pine Cafe. Once the connection is made, a new 

dialog box appears, as shown in Figure 2-14.

Click to connect
to a live 
videoconference
at White Pine Cafe

Click to open 
Phone Book window
Click to open the
Phone Book 

Click to find out who
is currently online
with CU-SeeMe

Click to test your 
video and audio
settings
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Figure 2-14. You can choose from a variety of conferences in the White Pine Cafe

This dialog box offers a choice of conferences. Click Join to join the default 

conference. The next dialog box tells you that you are connected and then you are 

presented with White Pine Cafe’s Message of the Day, shown in Figure 2-15.

Figure 2-15. Message of the Day from the White Pine Cafe

The Message of the Day is sent by the people who manage the White Pine Cafe 

conference, introducing you to the rules of their conference. Read this message to learn 

about any special rules or conditions relating to this conference, and then click Go! A 

new window will appear, called the White Pine Cafe (see Figure 2-16). This is the 

Conference Room window where videoconferencing takes place. Think of it as a 

virtual meeting room where you see and talk to others, and share written messages and 

graphics. Whenever you connect to a person or place, you will work in a Conference 

Room window, similar to this.
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Figure 2-16. The Conference Room window is where you see and talk to others

The Conference Room is divided into several sections, as shown in Figure 2-16. If you 

have a camera connected to your computer, you will see your video picture in one of 

the video windows. If other people are connected to the White Pine Cafe, you will see 

their names listed in the Participants List. You will also see video images of some of 

these people. For example, in Figure 2-16, Woodinator, DavidD, syzygy, and CU-Guy 

are other people who are in the cafe. Additional participants, such as Guillaume, 

Katrina, and others are also in the cafe but their video images are not currently 

displayed on your screen. When you are connected to the White Pine Cafe, you will 

not see the same list of names as shown in Figure 2-16 because you are connected to 

a changing group of real people. The list of participants will be different each time you 

connect. The number of video images you see depends on the type of network 

connection you have.

Menus

Toolbar

Participants
List

Audio 
controls and
indicators

Video windows

Chat window

Status bar
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Your name appears in the Participants List as CU-SeeMe User (Local). CU-SeeMe 

User is the default name assigned by CU-SeeMe. You can choose a different user 

name by defining a new user profile. To learn how to do this, see “Creating a Personal 

Profile” on page 3-22. The word (Local) is added to your name to indicate that it is 

being sent from your computer. You are the local participant. Other people in the 

conference are remote participants. In Figure 2-16, Willy is the name of the local 

participant.
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Seeing Other People
When the Conference Room opened, video images of some of the people in the 

Participants List appeared. By default, CU-SeeMe fills up all available video window 

frames with video images. To change this, see“Closing All Video Windows” on page 

2-15. Continue reading to learn how to control which people appear on your screen.

There are two categories of participants: senders and lurkers. Senders are sending 

video images and you can choose to see their images. Lurkers are not sending video 

images. Perhaps they don’t have cameras, or maybe they are choosing not to be seen. 

Whatever the reason, you will not receive a video image from a lurker. However, if 

you are sending video, both senders and lurkers can receive your image. 

Look at the Participants List in Figure 2-17. This list contains both senders and lurkers.

Figure 2-17. Participants List with senders and lurkers

To learn more about the Participants List and the information it presents, see 

“Participants List” on page 4-10.

Swapping Video Images
If you want to see a sender who is not currently displayed on your screen, you can click 

on a participant’s name to select it, and then drag it to a video window frame. This is 

called drag-and-drop. The new participant’s image will replace the previous image in 

that video window frame.

Senders have 
cameras

Lurkers do not 
have cameras
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Closing All Video Windows
If you don’t want all the video windows filled with images, or if you want more control 

over who you see on your screen, you can close all the video windows and then select 

only those participants you want to view. Note that this does not disconnect you from 

the conference; it only closes the video windows. You are still connected and others 

can still see you.

To close all video windows:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to Close All, then click.

3. All the video images disappear.

Showing All Video Windows
To fill up all the video window frames again, follow these steps. 

To show all video windows:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to Show All, then click.

3. All the video window frames will fill up with available video images.

To select individual video images, read the following section, “Seeing a Participant”.
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Seeing a Participant
You can choose which video images you want to see displayed on your screen. 

To see a participant:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to the name of the participant you want to select, then click.

3. The video image is now displayed in one of the open video window frames.

4. You can repeat this process to see video images from other participants.

You can continue this until all the video window frames are full, or you can stop at any 

time. You do not need to fill all the video windows. In fact, having fewer open video 

windows will increase the performance of your computer during the videoconference.

Remember that the number of video images you can display depends on the type of 

network connection you have.To learn more about displaying video windows, see 

“Video Windows” on page 4-17.

Being Seen
Just as you can choose to see other people in the Participants List, other participants 

can also choose to see you if you are a sender. Remember, if you have a camera 

connected to your computer, you are a sender. However, you can choose to become a 

lurker which prevents others from seeing your video picture.

To switch between being a sender and a lurker:

1. Make sure that your local video image is displayed in one of the video window 
frames. If it is not currently displayed, see “To see a participant:” on page 2-16 to 
learn how to display your video window.

2. Using the right mouse button, click on your video image. A dialog box appears. If 
you see a ✔ next to Send Video, then you are a sender.

3. Click Send Video to become a lurker. The ✔ disappears. You have stopped 
sending your video image to other participants

4. If you click Send Video again, you become a sender. You have now turned your 
video on and other participants can choose to see your video picture.
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Note that if you do not have a camera attached to your computer, you are always a 

lurker. Some group conferences limit the number of lurkers that can be connected at 

any given time. If that number has been reached and you switch from being a sender 

to being a lurker, then you may be disconnected from that conference. If this happens, 

call the conference again.
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Chatting with Others
Now that you are seeing some of the other people in the Conference Room, you may 

wish to exchange messages with them. One way to do this is to send typed messages 

to other people using Chat. Chat enables you to communicate, even if you don’t have 

a microphone or if your network connection is too limited to carry audio. 

Chat Window
Chat messages appear in the Chat window, as shown in Figure 2-18.

Figure 2-18. The Chat window allows you to exchange typed messages

To use the Chat window:

1. Type a message in the lower pane of the Chat window.

2. Press ENTER.

3. Your message now appears in the upper pane of the Chat window.

Other participants will see your message and you will see the messages that others are 

typing. You can follow Chat conversations in the upper pane of the window. Messages 

appear in the order in which they are received. 

To learn more, see “Chat Window” on page 4-23.

Type your 
message here
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Sending and Receiving Audio
In addition to seeing others, and exchanging Chat messages, you can also talk to other 

participants and hear their voices. To hear other participants, you must have speakers 

or headphones connected to your computer. To talk to other participants, you must 

have a microphone connected to your computer.

To learn about the audio features of CU-SeeMe, see “Audio Modes” on page 4-29 and 

“Audio Controls and Indicators” on page 4-31.
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Disconnecting From the Conference
When you are ready to leave the White Pine Cafe, you can disconnect from the 

conference in one of 2 ways.

To disconnect from a conference:

On the Conference menu, click Hang Up.

-or-

Click the Hang Up button on the toolbar.

This will disconnect you from the White Pine Cafe. Your videoconference session is 

over. The Conference Room window will close automatically and the Phone Book 

window will appear. Actually, it never disappeared; it remained on your desktop 

behind the Conference Room window. You can exit the application by choosing Exit 
from the File menu in the Phone Book. Or you can use the Phone Book to connect to 

other conferences. To learn more about using the Phone Book, see Chapter 3.
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Chapter 3

Using the Phone Book

The CU-SeeMe interface has two main windows: the Phone Book and the 

Conference Room. This chapter explains how to use the Phone Book and its 

components. See Chapter 4 for information on how to use the Conference Room.

Think of the Phone Book as your personal directory where you can list your friends, 

family members, business contacts, or anyone you might want to call. You can also 

think of the Phone Book as a speed dial list. You can make videoconference calls 

directly from the Phone Book.

The Phone Book includes a collection of Contact Cards. You can have a Contact 

Card for each person or place that you call. Some cards are included in CU-SeeMe 

to get you started and you can add or delete cards at any time.

You can also use the Phone Book to set up a Personal Profile for yourself. This 

profile defines information about you and your connections, such as your 

CU-SeeMe user name and communication settings. When you set up your Personal 

Profile, you create a Profile Contact Card about yourself. This card stores 

information which you can share with others.
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Components of the Phone Book
The components of the Phone Book are shown in Figure 3-1.

Figure 3-1. The Phone Book has several components

The components are explained in the following sections, as shown in Table 3-1.

Table 3-1. Where to find information on Phone Book components

To find out information about... Go to...

Phone Book Menus page 3-3

Phone Book Toolbar page 3-10

Contact Cards page 3-11

Contact Groups page 3-12

Status Bar page 3-14

Menus

Toolbar

Contact Group

List of 
Contact Cards

Selected
Contact Card

Status Bar
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Phone Book Menus
You can access CU-SeeMe commands from the Phone Book menus. You activate a 

menu by clicking on it. When you do, the menu’s commands are displayed. If a 

command is not available to you, it appears dimmed. Commands in the menu that are 

followed by ellipsis (...) need more information from you before they execute. These 

commands display dialog boxes that ask you for more information. Commands in the 

menu that are followed by a triangle indicate that a submenu is available. Pause your 

mouse pointer over that command and a submenu will appear. 

The commands and their descriptions are explained in the following sections.
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File Menu
The commands under the File menu are described in Table 3-2.

Table 3-2. The commands under the File menu in the Phone Book

File Command Description

New Contact Card Assistant... Opens the Contact Card Assistant, a 
step-by-step guide to creating a new 
Contact Card. 

This command is also available by clicking 
the New Card button on the Phone Book 
Toolbar.

New Contact Card Creates a new Contact Card, which can be 
edited later.

Import... Imports data and creates new Contact 
Cards.

Export > Saves the selected Contact Card to a file.

Send Mail... Sends e-mail to the address on the selected 
Contact Card. (Note that your e-mail 
program must be configured to use MAPI. 
See your e-mail vendor’s documentation to 
learn if it is MAPI-compliant.)

Print Setup... Displays the Print Setup dialog box where 
you can change the printer and print 
options.

Print Preview Displays the Print Preview dialog box, 
where you choose whether to preview a 
selected Contact Card or a group of Contact 
Cards.

Print... Displays the Print dialog box, where you 
choose whether to print a selected Contact 
Card or a group of Contact Cards.

1: most recent connection
2: previous connection

Lists the most recent connections you have 
made. Click on a name in this list to 
reconnect.

Exit Exits the CU-SeeMe program.
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Edit Menu
The commands under the Edit menu are described in Table 3-3.

Table 3-3. The commands under the Edit menu in the Phone Book

Edit Command Description

Undo Reverses the last text edit, such as 
renaming an entry in the list of Contact 
Cards.

Cut Removes the selected Contact Card from 
your Phone Book and puts it on the 
Clipboard.

Copy Copies the selected Contact Card to the 
Clipboard.

Paste Pastes the current content of the Clipboard.

Delete Deletes the selected Contact Card.

Select All Selects all the Contact Cards in the current 
Contact Group.

Find Displays the Find a Card dialog box where 
you can initiate a search of your Contact 
Cards.

Find Next Finds the next Contact Card, based on the 
search information you entered in the Find a 
Card dialog box.

Call Options... Displays the Call Options dialog box where 
you can change settings for Profiles, 
Listener, Security, and Phone Book options. 

This command is also available by clicking 
the Call Options button on the Phone Book 
Toolbar.

Contact Card Properties... Displays the Contact Card Editor dialog box 
where you can modify the properties of the 
selected Contact Card, including network 
settings used when calling the person or 
place on the selected card.

Edit Profile... Displays the Calling Options dialog box, 
where you can modify your Personal 
Profiles.
Chapter 3. Using the Phone Book          3-5



View Menu
The commands under the View menu are described in Table 3-4.

Test Setup... Displays the Test Setup dialog box where 
you can test and modify your video, 
microphone, speaker, and network settings.

This command is also available by clicking 
the Test Setup button on the Phone Book 
Toolbar, or from the Quick Start and Tips 
window.

Table 3-4. The commands under the View menu in the Phone Book

View Command Description

Status Bar Turns on and off the option of viewing the 
Status Bar at the bottom of the Phone Book. 
A ✔ indicates that the option is turned on.

Contact Card Turns on and off the option of viewing 
Contact Cards in the Phone Book. A ✔ 
indicates that the option is turned on.

Groups > Displays the list of Contact Groups and the 
Edit Groups command. The current group is 
indicated with a ✔.

Who’s Online... Displays the a list of users who are currently 
online using CU-SeeMe (and are registered 
with Four11 directory service). 

This command is also available by clicking 
the Who’s Online button on the Phone 
Book Toolbar.

Directory Services... Opens a Web browser and connects to the 
Four11 directory service Web page.

Table 3-3. The commands under the Edit menu in the Phone Book

Edit Command Description
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Call Menu
The commands under the Call menu are described in Table 3-5.

Table 3-5. The commands under the Call menu in the Phone Book

Call Command Description

Speed Dial current listing Calls the person or place on the selected 
Calling Card.

This command is also available by clicking 
the Speed Dial button on the Phone Book 
Toolbar.

Favorites > Displays a list of Contact Cards in your 
Favorites Contact Group. You can select a 
card from this group and call the person or 
place listed on the card.

Manual Dial... Displays the Dial dialog box where you can 
type an IP address to make a call.

This command is also available by clicking 
the Manual Dial button on the Phone Book 
Toolbar.

Create Multicast Conference... Opens the Multicast Assistant, a 
step-by-step guide to creating a multicast 
conference.
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Window Menu
The commands under the Window menu are described in Table 3-6.

Table 3-6. The commands under the Window menu in the Phone Book

Window Command Description

Phone Book Displays the Phone Book window. This 
command appears dimmed if the Phone 
Book is currently displayed.

Conference Room Brings the Conference Room window to the 
front. This command appears dimmed if you 
are not currently connected to a conference. 

WhiteBoard Brings the WhitePineBoard window to the 
front. This command appears dimmed if you 
are not currently in a WhitePineBoard 
session. 
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Help Menu
The commands under the Help menu are described in Table 3-7.

Table 3-7. The commands under the Help menu in the Phone Book

Help Command Description

CU-SeeMe Help Topics Opens the CU-SeeMe Help file and displays 
the Contents page.

Search for Help On Opens the CU-SeeMe Help file and displays 
the Find page.

CU-SeeMe Events Opens a Web browser and displays a Web 
page showing a schedule of events to which 
you can connect using CU-SeeMe.

Technical Support Opens a Web browser and displays the 
White Pine Software Technical Support Web 
page.

Registration Opens a Web browser and displays the 
White Pine Software Product Registration 
Web page, allowing you to register your 
copy of CU-SeeMe online.

Quick Start & Tips Displays the Quick Start and Tips window.

About CU-SeeMe... Displays information about your version of 
CU-SeeMe.
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Phone Book Toolbar
The Phone Book toolbar has buttons that provide shortcuts to many commands. As you 

move your mouse pointer over each button, the selected button becomes highlighted. 

You can then click the button to select it.

When you pause your mouse pointer on each button, a tool tip appears. No clicking is 

necessary. The tool tip gives you information about the function of each button.

The Phone Book toolbar buttons are explained in Table 3-8.

Table 3-8. The Phone Book toolbar buttons

Toolbar Button Description

Speed Dial

Calls the person or place on the selected 
Calling Card.

New Card

Opens the Contact Card Assistant, a 
step-by-step guide to creating a new 
Contact Card.

Manual Dial

Displays the Dial dialog box where you can 
type an IP address to make a call.

Who’s Online

Displays a list of users who are currently 
online using CU-SeeMe.

Call Options

Displays the Call Options dialog box where 
you can change settings for Profiles, 
Listener, Security, and Phone Book options.

Test Setup

Displays the Test Setup dialog box where 
you can test and modify your video and 
audio settings.

To learn more testing your setup, see “Test 
Your Setup” on page 6-13.
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Contact Cards
A Contact Card is like a business card or a card in a rotary file. It is a convenient way 

to present and store information about a person or place, including contact 

information. The list of Contact Cards contains the names of people and places you 

might want to call. Some cards are already in this list and you can add and delete cards 

at any time.

Selected Card
You can display a Contact Card for each entry in your Phone Book. The Contact Card 

currently displayed in your Phone Book corresponds to the highlighted name in the 

Contact Card list. When you click on another Contact Card name in the list, a different 

Contact Card is displayed.

A sample Contact Card is shown in Figure 3-2.

Figure 3-2. A Contact Card allows you to store information and make connections

To learn how to create a Contact Card, see “Adding Entries in the Phone Book” on 

page 3-19. To learn how to make a call using a Contact Card, see “Making Calls from 

the Phone Book” on page 3-15.

When you create a Personal Profile (see “Creating a Personal Profile” on page 3-22), 

you also create a Profile Contact Card about yourself. You can share your Profile 

Contact Card with others and receive cards from other people. This is similar to 

exchanging business cards, except that you distribute a card file electronically, rather 

than handling paper cards. To learn more, see “Getting Information About a 

Participant” on page 4-34.
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Contact Groups
You can organize your collection of Contact Cards into categories, or Contact Groups. 

For example, you might want a group containing all of your business contacts and 

another group containing all of your social contacts. Or if you share you computer with 

other people, each person might want his/her own Contact Group. You can have the 

same name listed in more than one Contact Group. For example, you might want a 

co-worker listed in your Business Contact Group and also in your Social Contact 

Group.

You can select a Contact Group by clicking the arrow (as shown in Figure 3-3) or you 

can select or edit Groups from the View menu.

Figure 3-3. The list of Contact Groups is displayed

To select Contact Groups from the View menu:

1. On the View menu, point to Groups.

2. Point to the Contact Group you want to select, then click.

3. The group you selected is now displayed in your Contact Card list and the first 
card in the list is shown as the selected card. If you select the All Contact Group, 
you will see all the Contact Cards in your Phone Book.
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To edit Contact Groups:

1. On the View menu, point to Groups.

2. Point to Edit Groups, then click. The Edit Groups window is displayed, as shown 
in Figure 3-4.

Figure 3-4. The Edit Groups window lets you add, delete, and modify Contact Groups

If you delete a Contact Group that contains Contact Cards, these cards will still be 

available from the All group.

To learn how to move a Contact Card from one Contact Group to another, see “Editing 

a Contact Card” on page 3-21. To learn about Parental Control, see “Using Parental 

Control” on page 3-35. 

Click to add a New Contact
Card and to assign sharing 
and Parental Control properties

Click to delete
the selected
Contact Group

Click to change the name of the selected
Contact Group and to change the
sharing and Parental Control properties

Selected Group
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Status Bar
The Status Bar, located at the bottom of the Phone Book, provides tips and information 

about your current status. For example, when you click and hold on a toolbar button, 

the Status Bar presents information about that button. Also, when you pause your 

mouse pointer on a menu command, the Status Bar presents information about that 

command. 

When you are not connected to a conference, the Status Bar displays information 

telling you which Phone Book entry you have selected. Once you have made a 

connection, the Phone Book Status Bar tells you how long you have been connected.
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Making Calls from the Phone Book
You can make videoconference calls directly from the Phone Book. To make a call, 

you can use the Speed Dial function, you can manually dial a number, or you can select 

a person to call from a list of who’s online. These methods are explained in the 

following sections.

Speed Dialing
The Speed Dial allows you to call a person or place listed on the selected Contact Card. 

To call using Speed Dial:

1. Click on a Contact Card listed in the Phone Book.

2. Click the Speed Dial button on the Phone Book toolbar. This begins your 
connection to the person or place listed on the selected Contact Card.

3. While your computer is establishing the connection, you will see the window 
shown in Figure 3-5. If you have a camera and are sending video, you will see 
your picture in this window. You will also see the Contact Card of the person or 
place to which you are connecting.

Figure 3-5. Your computer is establishing a connection
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4. Once the connection is made, this window will change to display a list of 
conferences you can join (see Figure 3-6). Select a conference, then click Join.

Figure 3-6. Choose a conference to join

5. After you select a conference, the window will display a Message of the Day as 
shown in Figure 3-7. This message is unique to each conference. Read this 
message to learn about any special rules or conditions relating to this conference.

Figure 3-7. Message of the Day

6. Click Go! to enter the conference.

In addition to these steps, there are other ways you can call using Speed Dial. These 

are described next.

If the conference is
password-protected, you
will need to enter a 
password before joining.

ACV indicates that
this conference 
supports Audio, 
Chat. and Video.

(9/5) indicates that there
are currently 9 senders 
and 5 lurkers in this
conference.

If the conference 
requires an ID, you 
will need to enter
it here.
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Other ways to call using Speed Dial:

◆ Double-click on a Contact Card in the list. 

- or - 

◆ Click on the phrase Click here to call on the selected Contact Card. 

- or - 

◆ Using the right mouse button (right-click), select a Contact Card in the list. A 
dialog box appears. Click Speed Dial. 

Manual Dialing
At times you might want to dial a person or place that is not already listed in your 

Phone Book. To do this, you can manually dial a number by typing the Internet 

Protocol (IP) address of the person or place you want to call.

To call using Manual Dial:

1. Click the Manual Dial button on the Phone Book toolbar.

2. The Dial dialog box appears. Type the IP address or the host name of the person 
or place you want to call. 

Optional: Click the Advanced tab. Type the Conference ID and Password for the 
conference server to which you want to connect, if a password is required. 

3. Click Dial. This begins your connection.

Calling Who’s Online
CU-SeeMe can tell you who is currently online using CU-SeeMe. You can select one 

of these names to call.

To find out who’s online:

1. Click the Who’s Online button on the Phone Book toolbar.

2. The Who’s Online window appears listing users who are currently online using 
CU-SeeMe. Click on a name in the Who’s Online list.
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3. Click the Speed Dial button on the Who’s Online toolbar. This begins your 
connection.

4. You can also click the Web Search button to open a Web browser and connect to 
the Four11 directory service Web page.

The names appearing in the Who’s Online list are people who are currently online 

using CU-SeeMe and have registered with Four11 directory service. To learn more 

about registering with Four11 directory service, see “Registering With an Online 

Directory Service” on page 6-22.
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Adding Entries in the Phone Book
You can add new Contact Cards to the Phone Book. The easiest way to do this is using 

the Contact Card Assistant. The Contact Card Assistant guides you through the steps 

needed to create a new Contact Card.

To use the Contact Card Assistant:

1. Click the New Card button on the Phone Book toolbar.

2. The New Contact Card Assistant is displayed, as shown in Figure 3-8.

Figure 3-8. The New Contact Card Assistant makes it easy to create new Contact Cards

Follow the steps in the New Contact Card Assistant. It guides you through the creation 

of a Contact Card and adds a new entry to the Contact Card list.

You can also add a new entry in the Phone Book without using the Assistant. This is 

useful if you want to add an entry but don’t have much information to complete a 

Contact Card.

To add a simple Phone Book entry:

1. On the File menu, click New Contact Card.

2. A new Contact Card is created with the name Untitled. To rename this card, type 
the new name now. This new name will appear in the Contact Card List in the 
Phone Book.
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The name you typed will be added to your Contact Card List and a New Contact Card 

will be created. This card will have minimal information, and you can edit this card at 

any time to add or change information. You can also change the name of the Contact 

Card as it appears in the Contact Card list.

You can also import files which contain data that can be converted into Contact Cards.

To import data into your Phone Book:

1. On the File menu, click Import.

2. The Open dialog box is displayed, as shown in Figure 3-9.

Figure 3-9. You can import files and convert the data to Contact Cards

3. You can import several types of files. Click the arrow (as shown in Figure 3-9) to 
display a list of file types that you can import. 

CU-SeeMe files (*.cu) and CSV files (*.csv) can be imported directly as contact cards 

into the currently selected Contact Group. Nickname files (Nickname.ini) contain the 

data from the Phone Book in earlier versions of CU-SeeMe. If you have an earlier 

version of CU-SeeMe, you can import the Nickname files to bring your old Phone 

Book entries into your new Phone Book. If you select Text files (*.txt), the Phone 

Book Import Assistant is displayed. This is a step-by-step guide to creating new 

Contact Cards using existing text files.
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Editing a Contact Card
Once you have created a Contact Card, you can edit it to add or change information, 

or you can delete the card to remove it from the Phone Book

To edit a Contact Card:

1. Select the entry in the Contact Card list.

2. On the Edit menu, click Contact Card Properties. The Contact Card Editor 
appears, as shown in Figure 3-10.

Figure 3-10. The Contact Card Editor lets you modify Contact Cards

3. Select a tab to choose what aspect of the card you want to edit. For example, the 
General tab lets you edit the Nickname text field, which is the name that appears 
in the Contact Card list. 

4. When you have completed all your edits to the Contact Card, click OK.

To delete a Contact Card:

1. Select the entry in the Contact Card list.

2. On the Edit menu, click Delete.

3. You are asked if you are sure you want to delete this card. Click Yes to delete the 
card or No to cancel the delete process.
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Creating a Personal Profile
A Personal Profile identifies you to other people on the network.Your Personal Profile 

includes your CU-SeeMe name, which is your on-screen name that others see when 

you are conferencing. When you create a Personal Profile, you also create a Profile 

Contact Card about yourself. Your Profile Contact Card is like a business card that you 

can exchange with others electronically. To learn how to exchange Contact Cards with 

others, see “Getting Information About a Participant” on page 4-34. 

If you choose to videoconference on public conferences, your Profile Contact Card can 

be seen and saved by anyone with CU-SeeMe; therefore, you should be careful what 

information you choose to display on your Profile Contact Card. For example, if you 

do not want strangers to have your phone number, then you should not list it on your 

Contact Card. 

Your Personal Profile also contains information about Parental Control options, and 

your computer setup. To learn more about Parental Control, see “Using Parental 

Control” on page 3-35.

You can create one or more Personal Profiles. For example, you might want one 

profile for personal use and one for home use, or you might want different profiles for 

different members of your family. 

To create a Personal Profile:

1. Be sure that you are not connected to a conference when you create your Personal 
Profile. The Phone Book window should be your active window. If it is not, then 
click on the Phone Book window to make it the active window.

2. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click. 
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3. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-11.

Figure 3-11. You can create and edit your Personal Profile

4. Click New.

5. The Personal Profile Assistant is displayed, as shown in Figure 3-12.

Figure 3-12. The Personal Profile Assistant makes it easy to create a Personal Profile

Click to create a new profile.

Click to edit the selected profile.

Click to create a profile which is
a duplicate of the selected one.
You can then edit this new 
profile.

Delete the selected profile.

Click in the check box
to use this profile for
your next videoconference.

Click on a profile name
to select it.

Select this to be prompted
to choose a profile
each time you start
CU-SeeMe.
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Follow the steps in the Personal Profile Assistant. It guides you through the creation 

of a Personal Profile including a Profile Contact Card. You can repeat these steps to 

add additional profiles.
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Editing a Personal Profile
You can edit your profiles if you want to add or change any information. For example, 

you might want to change your CU-SeeMe name, which is your on-screen name that 

others see when you are conferencing.

To edit a Personal Profile:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-11.

3. Click Edit.

4. The Personal Profile Editor appears, as shown in Figure 3-13.

Figure 3-13. The Personal Profile Editor lets you modify your profile

5. Select a tab to choose what aspect of the Personal Profile you want to edit. For 
example, the General tab lets you edit your CU-SeeMe name, which is the user 
name that appears when you conference with others.

6. When you have completed all your edits to the Personal Profile, click OK.
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To delete a Personal Profile:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click.

1. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-11

2. Click Delete.

3. You are asked if you are sure you want to delete this profile. Click Yes to delete 
the profile or No to cancel the delete process.
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Using the Listener
The Listener is a program that lets you know if someone is trying to call your computer 

for a videoconference, even when CU-SeeMe is not running or when you are already 

connected to a conference or another call. It will listen for incoming calls and it will 

notify you. You can accept, ignore, or refuse the call. 

The Listener is automatically turned on when CU-SeeMe is running. This means that 

if you are in a videoconference and someone else calls you, you will be notified of the 

call so you can accept it or not. If you accept it, you will be disconnected from your 

current videoconference because you cannot be connected to two conferences 

simultaneously. You will then be connected to the new, incoming call.

Enabling the Listener
If you want to have the Listener running even when CU-SeeMe is not running, you will 

need to enable the Listener to run as a start-up program. This means that the Listener 

will start automatically when Windows starts on your computer. In this scenario, you 

will be notified of an incoming call even when CU-SeeMe is not running. You can 

accept or deny the call. If you accept the call, the Listener automatically starts 

CU-SeeMe so you can begin conferencing with the caller.

To enable the Listener:

1. Click the Call Options button on the Phone Book toolbar. Point to Listener, then 
click. 
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2. The CU-SeeMe Call Options dialog box appears (with the Listener tab displayed), 
as shown in Figure 3-14.

Figure 3-14. You can enable the Listener to notify you of incoming calls

3. Select the check box labeled Run listener at startup, as shown in Figure 3-15.

Figure 3-15. You can enable the Listener to run even when you are not running CU-SeeMe

4. The button next to this check box toggles between two modes. It says either 
Suspend listening now or Resume listening now. If you decide that you want to 
stop running the Listener temporarily, click Suspend listening now. When you 
click it, the button changes to say Resume listening now. The label on the button 
tells you what will happen when you click the button. When you want to resume 
using the Listener, click the button again. For now, the button should say Suspend 
listening now.

5. The next time you restart Windows on your computer, the Listener will be enabled 
to run even when CU-SeeMe is not in use. You will see the Listener icon in 
the Windows Taskbar, letting you know that the Listener is running. To turn the 
Listener off, right-click on the icon in the Taskbar, point to Disable Listening, 
then click. The icon changes to indicate that the Listener is turned off.

Listener Enabling
lets you turn the
Listener on or off

Listener Active Filters
let you block calls
from specific users

Default Listener Settings
lets you change the
way you are notified
of incoming calls or
block all incoming calls

Select this to have the 
Listener run every time
you start your computer.

Click to stop running 
the Listener 
temporarily. 
Click again to resume
running the Listener.
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Changing Listener Default Settings
The Listener is set up to notify you of all incoming calls by displaying a Notification 

dialog box, and ringing ten times. If you do not accept an incoming call within ten 

rings, the call is automatically refused. You can change these default settings.

To change the Listener default settings:

1. Click the Call Options button on the Phone Book toolbar. Point to Listener, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Listener tab displayed), 
as shown in Figure 3-14.

3. At the bottom of this dialog box is a section called Default Listener Settings. 
Click the Default Settings button to display the Listener Default Settings dialog 
box, shown in Figure 3-16.

4. There are two sections of this tab that you can modify. One is a section called Get 
my attention, which defines how you want to be notified of incoming calls, and 
the other section is called Call response, which defines how you want the Listener 
to respond if you don’t answer the incoming call. These are explained in the 
following sections.

Figure 3-16. You can modify the default settings of the Listener

 

Get my attention lets you
select a notification 
method for incoming calls

Call response lets you
choose a response if
you don’t answer an
incoming call
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Modifying the Notification Method
Using the Listener Default Settings dialog box, you can define how you want to be 

notified of incoming calls. In the section of the Listener Default Settings dialog box 

called Get my attention, you can select the sound you want to hear when you are 

notified of a call. This section is shown in Figure 3-17.

Figure 3-17. You can define how you want to be notified of incoming calls

You can select one of the following ring options:

◆ No ring

◆ Standard ring

◆ Distinctive ring

If you select Distinctive ring, you then need to click the Browse button to find a .wav 

file on your hard disk. For example, you can browse to the CU-SeeMe folder (usually 

on the C: drive at C:\Program Files), then the sounds folder, and finally select 

conflist.wav or any other .wav file. 

Use the Play button to listen to the sound. This sound will replace the standard ring to 

notify you of an incoming call.

If the Open Notify Dialog check box is selected, you will also see a dialog box 

whenever you receive an incoming call. This dialog box makes it easy to respond to 

the call.

If the Flash check box is selected, a portion of your screen will flash to get your 

attention and let you know that you are being called. If you select Flash, then you can 

use the drop-down list to select which portion of the screen will flash.

You can select whether
you want the Listener to 
ring when you are called.
Then select the ring sound.
Here a Distinctive ring
is selected.

Click the Browse button
to select a ring from the
CU-SeeMe Sounds folder
or select any .wav sound.
 

Click to play (and stop)
the selected sound.

Select to open a dialog 
box to notify you when 
you are being called.

Select to have a part of 

the 

your screen flash when
you are being called. 
Use the drop-down list
to select which part of 
your screen will flash.
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Modifying the Listener Response
Using the Listener Default Settings window, you can define how you want the Listener 

to respond if you don’t answer the incoming call. In the section of the Listener Default 

Settings dialog box called Call response (shown in Figure 3-18), you can select the 

following response options:

◆ Ring forever

This means that the Listener will continue to ring until the caller disconnects.

◆ Ignore this call with no message

This means that calls will automatically be refused and the caller will receive no 
feedback from your computer. If this is selected, you will not be notified of 
incoming calls.

◆ Refuse call after x rings with message

This means that you can define how many times the Listener will ring before 
refusing calls. If you type a message into the box below this choice, that message 
will be sent to the caller once the call is refused. For example, you can send the 
following message to your caller: 

“I am not at my computer right now. Please call again later.”

Figure 3-18. You can define how the Listener will respond if you don’t answer the call

Choose how CU-SeeMe
should respond when
you don’t answer an
incoming call. Here, the 
call will be refused after 
10 rings and a message 
will be displayed to the 
caller.

Type the message that
you want to caller to
receive.
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Creating Listener Active Filters
There may be times when you don’t want the Listener to use the default settings. For 

example, you might want to block out calls from one particular caller, but receive 

notification when anyone else calls. Or you might want to be notified of calls from 

only a small group of special friends. You can override the default settings by creating 

Listener Active Filters.

To create Listener Active Filters:

1. Click the Call Options button on the toolbar. Point to Listener, then click.

2. The CU-SeeMe Call Options dialog box appears (with the Listener tab displayed), 
as shown in Figure 3-14.

3. There is a section of this dialog box called Listener Active Filters. Click the New 
button to create a new filter. The New Listener Filter dialog box appears, as shown 
in Figure 3-19.

Figure 3-19. You can customize the Listener for specific incoming calls using filters

Use this section to define
whose calls will be 
filtered.
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You can create a filter that will override the default Listener settings. For example, 

using the sample filter shown in Figure 3-20, if a user with the CU-SeeMe name of 

Jason tries to call you, the call will automatically be refused and Jason will receive the 

following message: 

“I am not accepting your call at this time.”

Figure 3-20. This sample Listener Filter will stop incoming calls from Jason

You can also use the Listener Filter to notify you of certain calls even if your default 

setting ignores all calls. Simply create a Listener Filter to accept a call from a specific 

user. The filters always override the default settings. 

If you create multiple filters, CU-SeeMe implements the filters in sequence, from the 

top of the list to the bottom. You can change the sequence of the filters, using the up 

and down arrows next to the list of filters, as shown in Figure 3-14.

Calls from Jason will be
filtered

Jason will receive this
message when his call
is refused

Calls from Jason 
will be refused
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Answering an Incoming Call
If you have selected the default Listener settings, the Listener Status window (see 

Figure 3-21) appears when another user is calling CU-SeeMe on your computer.

Figure 3-21. The Listener Status dialog box notifies you of incoming call

You can choose to accept the call or you can reject the call. You can reject the call in 

two ways. If you click Ignore, the caller will not connect to your computer. If you click 

Refuse, the caller will not connect to your computer and, if you defined a message in 

the Listener Default Settings dialog box (see Figure 3-16), that message will be sent to 

the caller.

The CU-SeeMe user name
of the caller is displayed

Select this to receive the 
caller’s video when
connected

Select this to transmit your 
video when connected

Click here to ignore the call Click here to refuse the call
and send a message (if defined)

Click here to accept the call

Click to display
additional options
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Using Parental Control
CU-SeeMe parental control allows you to put restrictions on the CU-SeeMe calls that 

are made from your computer and the calls accepted by your computer. 

Configuring Parental Control
You can configure parental control to restrict other users from accessing all the 

features of CU-SeeMe. You decide which features you want disabled. 

To configure parental control:

1. Click the Call Options button on the Phone Book toolbar. Point to Security, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Security tab displayed), 
as shown in Figure 3-22.

Figure 3-22. You can configure and enable parental control

3. Click the button labeled Configure Parental Control Restrictions.The Parental 
Control Restrictions window appears. 
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4. Click the Communications tab (see Figure 3-23).

Figure 3-23. You can restrict incoming and outgoing calls, as well as multicast conferencing

5. Click the items you want to allow access to. 

6. Click OK.
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7. Click the Usage tab (see Figure 3-24).

Figure 3-24. You can restrict access to Web launching and Phone Book features

8. Click the items to indicate the privileges you want to allow. 

9. Click OK.

10. Click the Profiles tab (see Figure 3-25).

Figure 3-25. You can restrict a user from changing profiles
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11. Click the items to indicate the privileges you want to allow. 

12. Click OK. You are returned to the Security tab.

13. Click OK again.

You have now configured parental control options; however, you have not yet enabled, 

or turned on parental control. To do this, read the following section.

Enabling Parental Control
Parental control is password-protected. A parent can set controls which can be turned 

on or off and modified only by someone who knows the password.This prevents others 

from tampering with the control configurations you chose in the previous section.

To create a password:

1. Click the Call Options button on the Phone Book toolbar. Point to Security, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Security tab displayed), 
as shown in Figure 3-22.

3. If you have not yet created a password, you will need to do this. Click the Create 
Password button. The New Parental Control Password dialog box appears, as 
shown in Figure 3-26.

Figure 3-26. Enter or create a password to protect the parental controls

4. Enter an existing password or create a new password. Then click OK.

 

Enter an existing password here

To create a new password, type it here
Type the new password again, to confirm it
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To enable parental control:

1. In the CU-SeeMe Call Options dialog box (see Figure 3-22), click Enable 
Parental Control.

2. Type your password in the Parental Control Password dialog box. This turns on 
parental control.

3. Repeat this step to turn off parental control.

4. Click OK when you are done.
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Multicast Conferences
CU-SeeMe allows you to conference with multiple users (Windows users only at this 

time) in a multicast conference. In a multicast conference, you send a stream of video, 

audio, Chat, WhitePineBoard, and conference control data over a network to many 

users simultaneously. Joining a multicast conference is similar to connecting to a 

conference on a Reflector. Only users with CU-SeeMe Version 2.1 (or later) can 

participate in a multicast conference.

Once the multicast conference has been created (see “Creating a Multicast 

Conference” on page 3-42), any user can join the multicast conference by selecting the 

conference from the Phone Book. Users can also join by connecting (point-to-point) 

to any participant who has already joined the conference. The Participants List will not 

display any participants until a user (in addition to the conference creator) connects to 

the IP address of the multicast conference.

CU-SeeMe multicast conferences are “loosely coupled” which means that participants 

can join the multicast, or disconnect from the multicast at any time. Even the creator 

of the conference can disconnect and the conference will continue to exist as long as 

more than one user is still connected to this multicast. When all participants disconnect 

from the multicast conference, then that conference no longer exists.

Multicast is a special TCP/IP protocol for sending data over an IP network from a 

single source to many recipients. This requires a TCP/IP stack that supports multicast. 

The Microsoft VxD TCP/IP stack, which is included with the Windows 95 and 

Windows NT operating systems, supports multicast.

Because multicast is a relatively new TCP/IP protocol, not all routers, bridges, and 

gateways support multicast. Therefore you may not be able to multicast over the 

Internet or over your LAN or WAN. Many modem users may find that they are not 

able to join or create multicast conferences. If you want to use multicast over your 

corporate LAN or WAN, check with your Systems Administrator or your Internet 

Service Provider first.

Your ability to participate in a multicast conference also depends on the network 

interface card (commonly called a NIC, or an Ethernet card) installed in your 

computer. Please consult your hardware supplier and Internet Service Provider to find 

out if they support multicast conferencing. For more information on compatible 

network interface cards check the CU-SeeMe Frequently Asked Questions on the 

World Wide Web at http://www.cuseeme.com/support.
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There are two types of multicast conferences: 

◆ Group Conference 

This is an interactive conference where all users who are connected can send and 
receive audio and video, and can use the other features of CU-SeeMe, such as 
Chat and the WhitePineBoard.

◆ Cybercast 

This is a one-way conference where only the conference creator can send out 
video and audio. Others who are connected can see and hear the “cybercasted” 
audio and video, but they cannot send audio and video.

Multicast conferences have no limit to the number of participants that can join. 

However, due to bandwidth considerations, a multicast group (interactive) conference 

should generally not exceed100 participants. A multicast cybercast conference 

(one-way) has no limits on the number of participants. Multicast cybercast conferences 

will not have a Participants List. However the conference creator can see how many 

participants are viewing the broadcast. 

Enabling Multicast
Before you can create or join a multicast conference, you must be sure that your 

Personal Profile is set to enable a multicast.

To enable multicast:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-11.

3. Click Edit.

4. The Personal Profile Editor appears, as shown in Figure 3-13. Select the General 
tab.
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5. Select the Enable Multicast Connections check box to turn on the ability to 
participate in multicast conferences. When you select this check box, CU-SeeMe 
will check to see if a TCP/IP stack with multicast support is installed in your 
computer. If this stack is found, then this box will remain selected. If an 
appropriate TCP/IP stack is not found, this box will revert to being unselected and 
you will not have the option of creating or joining a multicast conference.

6. Click OK.

Creating a Multicast Conference
If you have multicast-capable network connections and you have multicast enabled, 

you can create a multicast conference. CU-SeeMe includes a Multicast Assistant to 

guide you.

To create a multicast conference:

1. From the Call menu, click Create Multicast Conference. 

2. The Multicast Conference Assistant is displayed, as shown in Figure 3-27. 

Figure 3-27. The Multicast Conference Assistant makes it easy to create a multicast conference 

3. Click Next to define the type of multicast conference you want to create.
3-42     CU-SeeMe User Guide



4. Click the Group conference option to create an interactive conference where all 
participants can exchange video and audio, Chat, and share WhitePineBoard 
workbooks.

- or -

Click the Broadcast conference option to create a one-way conference (a 
cybercast) where only you can send video and audio. Participants who connect to 
this conference can see and hear you, but they cannot send data. 

5. Select an area from the Area drop-down list. These areas determine how far your 
multicast conference will reach. Before selecting Region, Continent, or World as 
your multicast conference area, contact your network manager to ask whether you 
have the appropriate Internet access.

• Subnet - Stay within your local area network (LAN). Your multicast will not 
go through routers.

• Site - Stay within your Wide Area Network (WAN). For example, your 
multicast may stay within your corporate network. This will work only if your 
WAN has multicast routers.

• Region - Extend to the Internet for a defined Time to Live (TTL). Your 
multicast will be limited to a defined area on the Internet. Click Advanced 
Configuration to define the TTL.

• Continent - Extend to the Internet for an extended Time to Live (TTL). Your 
multicast will be limited to a defined area on the Internet. A Continent will have 
a greater Time to Live value than a Region. Click Advanced Configuration to 
define the TTL.

• World - Extend to the widest range for a defined Time to Live (TTL). Your 
multicast will be capable of extending globally. Click Advanced 
Configuration to define the TTL.

6. Click Next. Click Next again to enter information to describe the conference.

7. Type a conference name. This will appear in the Phone Book of any CU-SeeMe 
user who is able to connect to your conference. See“Joining a Multicast 
Conference” on page 3-44 for information about how multicast conferences 
appear in the Phone Book.

8. Type a description of your conference. This will appear on a Contact Card for 
your multicast conference. This Contact card will also appear in the Phone Book 
of any CU-SeeMe user who is able to connect to your conference.

9. Click Next. Click Next again to enter contact information.
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10. Contact information allows other users to contact you for more information about 
the multicast conference you have created. This information is optional. You can 
type your name, a URL for your Web page, and your phone number. Your Web 
page could include information about your multicast conference. Your phone 
number allows people to contact you directly via the telephone. Remember to 
include your complete phone number because participants in your conference 
could be located anywhere in the world.

11. Click Next. You are now presented with a Contact Card for your conference. This 
will automatically appear in the Phone Book of any user who is able to connect to 
your conference.

12. Click Finish. This closes the Multicast Assistant and begins the multicast 
conference.

Joining a Multicast Conference
If you have multicast-capable network connections and you have multicast enabled, 

you can join multicast conferences. All multicast conferences that are available to you 

are listed in your Phone Book. 

To join a multicast conference:

1. On the View menu, point to Groups.

2. Point to the Multicast Contact Group, then click.

3. The multicast group is now displayed in your Contact Card list and the first card 
in the list is shown as the selected card. You can call a multicast conference as you 
would call any other conference. (See “Making Calls from the Phone Book” on 
page 3-15.) If this list is empty, it means that no multicast conferences are 
currently available to you. 
3-44     CU-SeeMe User Guide



Chapter 4

Using the Conference 
Room

The CU-SeeMe interface has two main windows: the Phone Book and the 

Conference Room. This chapter explains how to use the Conference Room. See 

Chapter 3 for information on how to use the Phone Book. To enter the Conference 

Room, you must make a call from either the Phone Book (see “Making Calls from 

the Phone Book” on page 3-15) or the Quick Start window (see “Connecting to the 

White Pine Cafe” on page 2-10).

The Conference Room window is where videoconferencing takes place. Think of it 

as a virtual meeting room where you see and talk to others. Whether you are 

connected in a point-to-point conference, a group conference, or a cybercast, you 

will be doing it in the Conference Room.

The Conference Room window was introduced in Chapter 2. This chapter describes 

additional features.
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Components of the Conference Room
The components of the Conference Room window are shown in Figure 4-1.

Figure 4-1. The Conference Room window

The components are explained in the following sections, as shown in Table 4-1.

Table 4-1. Where to find information on Conference Room components

To find out information about... Go to...

Conference Room Menus page 4-3

Conference Room Toolbar page 4-8

Participants List page 4-10

Video Windows page 4-17

Chat Window page 4-23

Audio Controls and Indicators page 4-31

Status Bar page 4-33

Menus

Toolbar

Participants
List

Audio 
controls and
indicators

Video windows

Chat window

Status bar
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Conference Room Menus
You can access CU-SeeMe commands from the Conference Room menu. You activate 

a menu by clicking on it. When you do, the menu’s commands are displayed. If a 

command is not available to you, it appears dimmed. Commands in the menu that are 

followed by ellipsis (...) need more information from you before they execute. These 

commands display dialog boxes that ask you for more information. Commands in the 

menu that are followed by a triangle indicate that a submenu is available. Pause your 

mouse pointer over that command and a submenu will appear. 

The commands and their descriptions are explained in following sections.

File Menu
The commands under the File menu are described in Table 4-2.

Table 4-2. The commands under the File menu in the Conference Room

File Command Description

Close Disconnects you from your current 
connection and closes the Conference 
Room window. The Phone Book window 
remains on your screen.

Send Mail... Opens your default e-mail program. (Note 
that your e-mail program must be 
configured to use MAPI. See your e-mail 
vendor’s documentation to learn if it is 
MAPI-compliant.)

Page Setup... Displays the Print Setup dialog box where 
you can change the printer and print 
options.

Print... Displays the Print dialog box, where you 
can print Chat text or video images.

Exit Disconnects you from your current 
connection and exits the CU-SeeMe 
program. 
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Edit Menu
The commands under the Edit menu are described in Table 4-3.

Table 4-3. The commands under the Edit menu in the Conference Room

Edit Command Description

Undo Reverses the last text edit in the Chat 
window input pane.

Cut Cuts the selected Chat text and puts it on 
the Clipboard.

Copy Copies the selected Chat text to the 
Clipboard.

Paste Pastes the current content of the Clipboard.

Delete Deletes the selected Chat text.

Select All Selects all the Chat text.

Customize... Displays the Customize dialog box where 
you can change settings for the Conference 
Room including video layout, Chat, audio, 
video, network and more. 

This command is also available by clicking 
the Customize button on the Conference 
Room toolbar.
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Conference Menu
The commands under the Conference menu are described in Table 4-4.

Table 4-4. The commands under the Conference menu in the Conference Room

Conference Command Description

Speak To > Displays a list of conference participants. 
Click on a name in the list to send audio to 
only that person. If you do not select a 
name, you will send audio to everyone in 
the conference. You must have a sound 
card and microphone to send audio.

This command is also available by clicking 
the Speak To button on the Conference 
Room toolbar.

Mute > Displays a list of conference participants. 
Click on a name in the list to stop 
receiving audio from that person. If you do 
not select a name, you will receive audio 
from everyone in the conference. You 
must have a sound card and speakers to 
receive audio.

Chat to > Displays a list of conference participants. 
Click on a name in the list to send Chat 
text to the selected person only. This is 
called Private Chat. If you do not select a 
name, you will send Chat to everyone in 
the conference. This is called Public Chat.

Video > Displays a list of conference participants 
who are sending video. Click on a name in 
the list to display that participant’s video.

This command is also available by clicking 
the Video button on the Conference 
Room toolbar.

Get Contact Card of > Displays a list of conference participants 
who are have Contact Cards available. 
Click on a name in the list to get that 
person’s contact card. 

Hold Temporarily freezes the audio and video 
that you send and receive. It does not 
freeze Chat text. 
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Window Menu
The commands under the Window menu are described in Table 4-5.

Speakers Turns your speakers on and off.

Hang Up Disconnects you from the current 
conference and closes the Conference 
Room.

This command is also available by clicking 
the Hang Up button on the Conference 
Room toolbar.

Table 4-5. The commands under the Window menu in the Conference Room

Window Command Description

Phone Book Displays the Phone Book window. 

This command is also available by clicking 
the Phone Book button on the Conference 
Room toolbar.

WhiteBoard Starts the WhitePineBoard program. Brings 
the WhitePineBoard window to the front if 
you are currently running the 
WhitePineBoard. 

This command is also available by clicking 
the WhiteBoard button on the Conference 
Room toolbar.

Table 4-4. The commands under the Conference menu in the Conference Room

Conference Command Description
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Help Menu
The commands under the Help menu are described in Table 4-6.

Table 4-6. The commands under the Help menu in the Conference Room

Help Command Description

CU-SeeMe Help Topics Opens the CU-SeeMe Help file and displays 
the Contents page.

Search for Help On Opens the CU-SeeMe Help file and displays 
the Find page.

CU-SeeMe Events Opens a Web browser and displays a Web 
page showing a schedule of events to which 
you can connect with CU-SeeMe.

Technical Support Opens a Web browser and displays the 
White Pine Software Technical Support Web 
page.

Registration Opens a Web browser and displays the 
White Pine Software Product Registration 
Web page, allowing you to register your 
copy of CU-SeeMe online.

Quick Start & Tips Displays the Quick Start and Tips window.

About CU-SeeMe... Displays information about your version of 
CU-SeeMe.
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Conference Room Toolbar
The Conference Room toolbar has buttons that provide shortcuts to many commands. 

As you move your mouse pointer over each button, the selected button becomes 

highlighted. You can then click the button to select it.

When you pause your mouse pointer on each button, a tool tip appears. No clicking is 

necessary. The tool tip gives you information about the function of each button.

The Conference Room toolbar buttons are explained in Table 4-7.

Table 4-7. The Conference Room toolbar buttons

Toolbar Button Description

Phone Book

Displays the Phone Book window. 

 WhiteBoard

Starts the WhitePineBoard program.

Video

Displays a list of conference participants 
who are sending video. Click on a name in 
the list to display that participant’s video.

Also allows you to fill all available video 
window frames with video images (Open 
All), or close all video images on your 
screen (Close All). 

 Speak To

Displays a list of conference participants. 
Click on a name in the list to send audio to 
only that person. If you do not select a 
name, you will send audio to everyone in 
the conference. You must have a sound card 
and microphone to send audio.

Customize

Displays the Customize dialog box where 
you can change settings for the Conference 
Room including video layout, Chat, audio, 
video, network and more. 
4-8     CU-SeeMe User Guide



Hang Up

Disconnects you from the current 
conference and closes the Conference 
Room.

Table 4-7. The Conference Room toolbar buttons

Toolbar Button Description
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Participants List
The Participants List shows the names of the people currently in the conference. In 

addition to listing names, the Participants List shows information about each of the 

participants, such as whether the person is a sender (sending a video image) or lurker 

(not sending a video image), is watching your video, and more. Once you understand 

which participants are senders and lurkers, you can decide whose video images you 

want to display on your screen. You can try to display the video image of a lurker, but 

instead of a picture you will get a blank frame with a message telling you that the 

chosen participant has “No Video Stream.”

To learn how to display the video images of participants in a conference, see “Seeing 

Video Images” on page 4-17. To learn how to change your own status from a sender 

to a lurker (and back again) see “Being Seen” on page 4-19.

Participants List Views
The Participants List displays the CU-SeeMe user name of each person in the 

conference, as well as status information about each participant. You can choose 

whether to view the Participants List as a detailed list, or as a group of large or small 

icons. By default, CU-SeeMe displays the Participants List as a detailed list. Try each 

view and choose the one that you prefer.

If you choose to view the Participants List as icons, then the information about each 

participant is conveyed using pictures. These pictures, or icons, illustrate whether the 

person is a sender or lurker, is watching your video image, and more. 

To learn more about the detailed list view, see “Participants List Viewed as a Detailed 

List” on page 4-12. To learn more about the small icon view, see “Participants List 

Viewed as Small Icons” on page 4-14. To learn more about the large icon view, see 

“Participants List Viewed as Large Icons” on page 4-15. 
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To change the Participants List view:

1. Click the Customize button on the Conference Room toolbar. Point to General, 
then click. The Customize dialog box appears (with the General tab displayed), as 
shown in Figure 4-2.

Figure 4-2. You can choose from three Participant List views

2. Select a Participants List view (as list, as small icons, or as large icons).

3. Click OK when you are done. The selected Participants List is now displayed in 
your Phone Book.

Select how you 
want to view the
Participants List
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Participants List Viewed as a Detailed List
By default, CU-SeeMe displays the Participants List as a detailed list. The detailed list 

shows the names of all the participants in the conference. It also shows icons, 

organized in columns, which indicate different things about the status of each 

participant. These icons are explained in Table 4-8.

Table 4-8. Icons in the detailed list

This icon... Indicates this about the participant...

This participant is sending video.

This participant’s video is currently displayed on your screen.

This participant is currently watching your video.

This participant and you are both watching each other’s 
videos.

This participant is hearing audio that you send.

This participant can send audio.

You have muted this participant. Therefore, you will not hear 
any audio sent by this participant.
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Figure 4-3 shows how these icons appear in the Participants List.

Figure 4-3. The Participants List shown as a detailed list

You can click on the heading at the top of each column to sort the list:

◆ Click on the Participant heading to sort the list so that the user names appear 
alphabetically. 

◆ Click on the  heading to sort the Participants List so that all the senders are 
grouped at the top and all the lurkers are grouped at the bottom. 

◆ Click on the  heading to group all the users who are currently seeing you. 

◆ Click on the  heading to group all the users who have speakers turned on. 

◆ Click on the heading to group all the users who can send audio.

Your name will always appear at the top of the list. You can extend the columns in the 

detailed list to show additional information about the participants. 

To see extended information:

1. Using the right mouse button, right-click on a blank area of the Participants List, 
such as the area below the list of names. A dialog box appears.

2. Point to Extended Info, then click.

Is sending 
video

Who’s seeing
whom

Is hearing 
you

Can send
audio

Is seeing you
(this person has your
video displayed)

You are seeing him
(this person’s video is
displayed on your screen)

You are both seeing
each other

You have muted this person

The box around
Woodinator 
indicates that
he was the last 
person to send 
audio
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3. The Participants List now displays additional columns of information. You may 
need to scroll the Participants List to the right or resize the Participants List to see 
all the information. (See “Resizing the Participants List” on page 4-16 to learn 
how to enlarge the Participants List.)

You can also display the extended information by selecting the Show extended 
information check box shown in Figure 4-2.

The new columns of information show the video and audio codec used, as well as the 

IP Address of each participant. To hide the extended information, repeat the previous 

steps (or deselect the Show extended information check box shown in Figure 4-2).

To learn how to view the Participants List in alternate ways, see “Participants List 

Views” on page 4-10.

Participants List Viewed as Small Icons
When you choose to view the Participants List as small icons, a small icon appears 

next to each name in the Participants List. Understanding these icons will enable you 

to know who is seeing you, hearing you, and more. Figure 4-4 explains the 

components of a small icon that represents a participant in a conference.

Figure 4-4. The components of the small icon used in the Participants List

Figure 4-5 shows the meaning of the small icons used to represent you (the local 

participant) in a conference.

Figure 4-5. These icons represent you (the local participant) in the small icon view

Is sending video

Is looking at you

Is listening to you

A box around the icon
means that this person is
currently displayed on 
your screen

This represents you when your video
 image is not displayed on your screen

This represents you when your video
 image is displayed on your screen
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Participants List Viewed as Large Icons
When you choose to view the Participants List as large icons, a large icon appears next 

to each name in the Participants List. Understanding these icons will enable you to 

know who is seeing you, hearing you, and more. Figure 4-6 explains the components 

of a large icon that represents a participant in a conference.

Figure 4-6. The components of the large icon representing a remote participant

Figure 4-7 shows the meaning of the large icons used to represent you (the local 

participant) in a conference.

Figure 4-7. These icons represent you (the local participant) in the large icon view

Moving the Participants List
The Participants List can be moved from the left side of the Conference Room to the 

right side. It can also be dragged out of the Conference Room window, becoming a 

separate, floating window. 

To move the Participants List:

1. Click on the frame around the Participants List.

2. Hold the mouse button down while you drag the Participants List to the right side 
of the Conference Room. Release the mouse button. If you have enough room on 
your monitor screen, you can drag the Participants List out of the Conference 
Room. This technique is called drag-and-drop.

3. You can drag-and-drop the Participants List back to its original location at any 
time.

A box around the icon
means that this person is 
currently displayed on your 
screen

Is sending video
Is looking at you 
Is listening to you

This represents you when your video
 image is not displayed on your screen

This represents you when your video
 image is displayed on your screen
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Note that when you move the Participants List, the audio controls and indicators move 

also. When you move them out of the Conference Room, they form a new window 

called the Conference Control Center, as shown in Figure 4-8. 

Figure 4-8. You can drag-and-drop the Participants List and audio controls out of the Conference 
Room window

Resizing the Participants List
You can change the size of the Participants List to make it more narrow or wide.

To resize the Participants List:

1. Move your mouse pointer over the splitter bar between the Participants List and 
the Video windows. The mouse pointer changes to a double arrow.

2. Click and drag the splitter bar to the right or left to change the size of the 
Participants List.
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Video Windows
Video images of conference participants appear in video window frames in the 

Conference Room. You can display multiple video windows simultaneously.

Seeing Video Images
Some participants in the conference may be sending video images (these people are 

called senders). Some participants may not be sending any video (these people are 

called lurkers). You can choose which senders’ video images you want to see 

displayed on your screen. You can try to display the video image of a lurker, but 

instead of a picture you will get a blank frame with a message telling you that the 

chosen participant has “No Video Stream.”

To see a participant:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to the name of the participant you want to select, then click.

3. That person’s video image is now displayed in one of the open video window 
frames on your screen.

4. You can repeat this process to see video images of other participants.

You can continue this until all the video window frames are full, or you can stop at any 

time. You do not need to fill all the video windows. In fact, having fewer open video 

windows will increase the performance of your computer during the videoconference.

In addition to the steps described previously, there are other ways you can display the 

video image of a participant. These methods are described next.

Other ways to see a participant:

◆ Double-click on a participant’s name. That person’s video image will appear in 
one of the open video window frames. 

- or - 
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◆ Using the right mouse button (right-click), select a participant’s name. A dialog 
box appears. Click Show Video. That person’s video image will appear in one of 
the open video window frames. 

- or - 

◆ Click a participant’s name to select it, and then drag it to an open video window 
frame. (This is called drag-and-drop.) That person’s video image will appear in 
the window frame to which you dragged it. This method allows you to place a 
video image in a specific frame. If you drag the participant’s name to a frame that 
already has a video image, the new participant’s image will replace the previous 
image.

- or - 

◆ On the Conference menu, point to Video. This displays a list of conference 
participants who are sending video. Click on a name to display that person’s 
video.

Closing Video Windows
You may want to close some of the video windows displayed on your screen. You can 

use the same methods that you used to display the video windows.

To close a video window:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images. The participants who are currently displayed on 
your screen are indicated by a ✔ in this list.

2. Point to the name of a participant who is displayed on your screen, then click.

3. That person’s video image is no longer displayed in a video window frame on 
your screen.

4. You can repeat this process to close video windows of other participants.

In addition to the steps described previously, there are other ways you can close the 

video image of a participant. These methods are described next.
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Other ways to close a video window:

◆ Double-click on a participant’s name. That person’s video image is no longer 
displayed in a video window frame on your screen.

- or - 

◆ Using the right mouse button (right-click), select a participant’s name in the 
Participants List. A dialog box appears. If that person’s video is currently 
displayed on your screen, you will see a ✔ next to Show Video. Click Show 
Video. That person’s video image is no longer displayed in a video window frame 
on your screen.

- or - 

◆ Using the right mouse button (right-click), select a video window. A dialog box 
appears. Click Hide.

- or -

◆ Double-click on a displayed video window. That person’s video image is no 
longer displayed in a video window frame on your screen.

- or - 

◆ On the Conference menu, point to Video. This displays a list of conference 
participants who are sending video. The participants who are currently displayed 
on your screen are indicated by a ✔. Point to the name of a participant who is 
displayed on your screen, then click. That person’s video image is no longer 
displayed in a video window frame on your screen.

Being Seen
Just as you can choose to see other people in the Participants List, other participants 

can also choose to see you if you are a sender. Remember, if you have a camera 

connected to your computer, you are a sender. However, you can choose to become a 

lurker which prevents others from seeing your video picture.

To switch between being a sender and a lurker:

1. Make sure that your local video image is displayed in one of the video window 
frames. If it is not currently displayed, see “Seeing Video Images” on page 4-17 
to learn how to display your video window.

2. Using the right mouse button, click on your video image. A dialog box appears. If 
you see a ✔ next to Send Video, then you are a sender.
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3. Click Send Video to become a lurker. The ✔ disappears. You have stopped 
sending your video image to other participants

4. If you click Send Video again, you become a sender. You have now turned your 
video on and other participants can choose to see your video picture.

Note that if you do not have a camera attached to your computer, you are always a 

lurker.

Changing the Layout of the Video Windows
You can arrange your video window frames to allow different combinations and sizes 

of video windows. 

To change the video layout:

1. Click the Customize button on the Conference Room toolbar. Point to Video 
Layout, then click. The Customize dialog box appears (with the Video Layout tab 
displayed), as shown in Figure 4-9.

Figure 4-9. You can customize the number and layout of video windows on your screen

2. Move the slider to select the maximum number of video windows you want to 
display. 

 

Move the slider to 
select the number of 
video windows you 
want to display.

Once you have selected
the number of windows,
you can click to choose 
the layout from the
options displayed.

Select this check box
to use a custom 
background color
around the video windows.
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3. Once you have selected the number of windows, the layout options are displayed 
in the dialog box. In some cases, only one layout option is available; in other cases 
multiple layouts are available. Click on a layout to select it.

4. If you want to customize the color that appears in the border around the video 
window frames, click to select the option named Use custom background color. 

5. Click the Color button. The Color dialog box appears. Click to select a color from 
the basic colors table. If you want more color choices, click Other. Chose a color 
from the palette shown. Use the slider to the right of the custom color palette to 
fine-tune the exact color you desire. When you have chosen the color you want, 
click OK. This closes the Color dialog box.

6. Click OK when you are done. The video layout you selected is now shown in the 
Conference Room.

Moving Video Windows 
Once you have a video image displayed on your screen, you can move that image to 

other locations on your screen. You can even drag it out of the Conference Room 

window, where it becomes a separate, floating window!

To move a video window:

1. Click on a video image displayed on your screen.

2. Hold the mouse button down while you drag the video image. Release the mouse 
button when you have dragged the image where you want it to go. For example, 
you can drag the image and drop it on your Chat window, or even outside of your 
Conference Room window.

3. Now you can resize the video image. Pause your mouse pointer over one of the 
edges of the video image frame, or over a corner of the frame. The pointer turns 
into a double arrow. Click and drag the double arrow to enlarge the video image. 
You can make the image as big as you want. You can shrink the image by 
dragging the double arrow again.

4. If you want to return the video image to the Conference Room, simply 
drag-and-drop it on the video window frames in the Conference Room window. 
The image will drop into the Conference Room and will automatically resize itself 
to fit the open frame.

You can also drag-and-drop a name from the Participants List to any other location on 

your screen to display that participant’s video image. 
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Resizing the Video Window display area
You can change the size of the Video Window display area to make it larger or smaller. 

The video images will automatically adjust to fit the new size.

To resize the video window display area:

1. Move your mouse pointer over the splitter bar between the Participants List and 
the Video windows. The mouse pointer changes to a double arrow.

2. Click and drag the splitter bar to the right or left to make the video images wider 
or narrower.

3. Now, move your mouse pointer over the splitter bar between the Chat window and 
the Video windows. The mouse pointer changes to a double arrow.

4. Click and drag the splitter bar up or down to make the video images taller or 
shorter.
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Chat Window
You can use Chat to exchange typed messages with other participants. This is 

especially helpful if either you or other users don’t have cameras or microphones, or if 

your bandwidth connection is too limited to carry audio.

The Chat window is located in the lower right portion of the Conference Room 

window and is divided into two sections (or panes), separated by a row of toolbar 

buttons and macro buttons, as shown in Figure 4-10.

Figure 4-10. The Chat window contains two panes, toolbar buttons, and macro buttons

To type Chat text:

1. Type a message in the lower pane of the Chat window. This is the input pane.

2. Press ENTER. Your message now appears in the upper pane of the Chat window. 
This is the display pane where the chat dialog appears.

Other users will see your message and you will see the messages they are typing. You 

can follow Chat conversations in the upper pane of the window. Messages appear in 

the order they are received.

Customizing Chat Style
You can modify the way text appears in the Chat window.

To customize Chat style:

1. Click the Customize button on the Conference Room toolbar. Point to Chat 
Style, then click. The Customize window appears (with the Chat Style tab 

Click to erase all 
Chat text in the 
upper (display) pane

Click to filter selected
Chat text Click to save Chat

text as a file
Click to print 
Chat text

Chat dialog
displays here

Type your 
message here
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displayed), as shown in Figure 4-11.

Figure 4-11. You can customize the appearance of Chat text

2. Select a category of text that you want to customize, such as all Chat Text, 
Participant Name, or URL.

3. Select a font type, size, and color. Select bold, italic or underlined text.

4. Select Enable URL Highlighting to display URL’s in a different font. (A URL, 
or Uniform Resource Locator, is an address used to locate information on the 
Internet. An example of a URL is http://www.wpine.com.) Select Enable URL 
Launching to turn URL’s in the Chat window into active links that launch a Web 
browser and connect you to that URL.

5. Select Enable Keyword Highlighting to assign specific words to appear in a 
different font or color. For example, if you want the words White Pine to appear 
in the color red in bold, 12 point size whenever it appears in a Chat discussion, 
follow these steps:

• Click to select Enable Keyword Highlighting.

• Click Add. The Add/Edit Text dialog box appears.

• Change the font size to 12.

• Change to the color to red.

• Click the bold button.
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• In the text box, type White Pine.

• Click OK.

6. Click OK when you have completed customizing the Chat style.

Using Chat Macros
A macro is a series of simple commands that allow you to automate tasks. You can use 

macros in the Chat window to eliminate typing of words, phrases, or symbols that you 

use often. Macros can be used for such things as your e-mail address, your favorite 

phrase, or even a smiley face.

To create Chat macros:

1. Click the Customize button on the Conference Room toolbar. Point to Chat 
Extensions, then click. The Customize window appears (with the Chat 
Extensions tab displayed), as shown in Figure 4-12.

Figure 4-12. You can assign Chat macros and filters 

2. Select Enable Chat macros.

3. Click Add to create a new macro.

4. Type the text that you want the macro button to represent.
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5. Select an icon from the list provided.

6. Click OK.

The selected icon will now appear in the toolbar in the Chat window. When you are 

typing Chat, you can click that macro button to insert the desired word or phrase. Note 

that when you create the macro, you can choose to press ENTER at the end of the 

macro text. This will cause the macro text to automatically appear in the upper Chat 

window pane when you click the macro button. If you do not press ENTER when 

composing your Chat macro text, your text will appear in the lower Chat window pane 

and you will need to press ENTER to send it.

Filtering Chat Text
There are times when you may not want your Chat window to show the messages of 

all the conference participants. Fortunately, CU-SeeMe allows you filter out unwanted 

text from your Chat window. Chat filters prevent you from seeing undesired Chat text 

sent by others, but they do not prevent the Chat text that you send from being seen by 

other participants. To send Chat to one selected participant only, see “Having a Private 

Chat” on page 4-27.

To filter Chat text:

1. Click the Customize button on the Conference Room toolbar. Point to Chat 
Extensions, then click. The Customize dialog box appears (with the Chat 
Extensions tab displayed), as shown in Figure 4-12. 

(You can also open this dialog box by clicking the filter button  on the toolbar 
in the Chat window.)

2. The Macro Filters section of the dialog box shows a list of all participants in the 
current conference. Click on a name in that list. Then click Exclude.

3. The name is now moved to the Exclude List. This means that Chat text from the 
selected person will not appear in your Chat window. You have excluded this 
person, or filtered this person from your Chat window.

4. You can repeat this process with other names to filter out more participants.

5. Now click on a name in the Exclude List. Then click Include. The name is now 
moved back to the Include List. Chat text from the selected person will appear in 
your Chat window once again.

 

4-26     CU-SeeMe User Guide



6. Using the option at the bottom of the dialog box, you can choose to have new 
participants in the conference automatically join either the Include List or the 
Exclude List. 

7. Click OK when you are done.

Having a Private Chat
You can establish a private Chat with another participant. This means that even in a 

busy conference, you can have your Chat messages go to only one person whom you 

select. Other participants will not see what you type in the Chat window, however you 

will continue to see Chat text from all the other participants.

To establish a private chat:

1. On the Conference menu, point to Chat to. 

2. Point to the name of the person to whom you would like to send private chat. Then 
click.

3. Now, anything you type in the Chat window will be sent only to the selected 
person.

4. To stop sending private chat to that person, go to the Conference menu, point to 
Chat to.

5. Point to the name of the person to whom you would like to send private chat. Then 
click.

6. Now, you are have returned to public chat mode.

When you are sending private Chat, you will see an indicator (●) next to your name 

in the Chat window, reminding you that you are sending private Chat. When another 

participant is sending private Chat to you, you will also see an indicator (●) next to 

that participant’s name in the Chat window, letting you know that you are receiving 

private Chat from that person. In addition, the words Public Chat in the Chat window 

changes to Private Chat to <name>. You can send private Chat to only one person at 

a time.
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Resizing the Chat Window
You can change the size of the Chat Window display area to make it larger or smaller. 

The video images will automatically adjust to fit the new size.

To resize the Chat window:

1. Move your mouse pointer over the splitter bar between the Participants List (or 
Audio Controls) and the Chat window. The mouse pointer changes to a double 
arrow.

2. Click and drag the splitter bar to the right or left to make the Chat window wider 
or narrower.

3. Now, move your mouse pointer over the splitter bar between the Chat window and 
the Video windows. The mouse pointer changes to a double arrow.

4. Click and drag the splitter bar up or down to make the Chat window taller or 
shorter.
4-28     CU-SeeMe User Guide



Audio Modes
Your computer must have a sound card installed if you want to send and receive audio. 

If you have a full-duplex sound card, you can send and receive audio simultaneously. 

This is similar to a telephone which allows you to talk and hear at the same time. If you 

have a half-duplex sound card, you send and receive audio, but you cannot do both at 

the same time. This is similar to a walkie-talkie with which each person must take turns 

speaking. 

With CU-SeeMe, you can transmit audio in your choice of two modes:

◆ Hands Free

You transmit audio continuously. Everything you say is transmitted. If you have 
a full-duplex sound card, CU-SeeMe selects Hands Free as your default audio 
mode.

◆ Push To Talk

You only transmit audio when you push a button. If you have a half-duplex sound 
card, CU-SeeMe selects Push To Talk as your default audio mode.

You can switch between Hands Free and Push To Talk modes while you are connected 

to a conference. 

To switch between Hands Free and Push To Talk modes:

1. Click the Customize button on the Conference Room toolbar. Point to 
Configuration, then click. The Customize dialog box appears (with the 
Configuration tab displayed), as shown in Figure 4-13.
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Figure 4-13. You can switch between Hands Free and Push To Talk modes

2. The upper portion of this dialog box is for audio settings. If the Hands Free 
Operation check box is selected, CU-SeeMe is in Hands Free mode. If this check 
box is not selected, CU-SeeMe is in Push To Talk mode. Click this check box to 
switch between these modes.

3. If you select Hands Free Operation, you can select additional check box options 
(Use Echo Reduction and High Mode). If you select Push To Talk, you can select 
only the High Mode option.

• Use Echo Reduction

This is used to eliminate feedback which can occur if your microphone is 
located near your speakers. Select this check box to eliminate feedback if it is 
a problem.

• High Mode

For most users, this check box should not be selected. Selecting High Mode 
results in a larger amount of redundant audio data transmitted. This may be 
useful if you have noisy network lines, however it sends more data and 
therefore uses more bandwidth.

4. Click OK when you are done.

To learn about audio codecs, see “Choosing an Audio Codec” on page 6-9.
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Audio Controls and Indicators
The audio controls and indicators consist of buttons, level indicators, and sliders, as 

shown in Figure 4-14.

Figure 4-14. Audio controls and indicators are grouped together in the Conference Room

Turning Your Speakers Off and On
To turn your speaker off, click the speaker button. A red slash appears on the button, 

indicating that this control is turned off. Click it again to turn it on.

Using Your Microphone in Hands Free Mode
If you are in Hands Free mode, click the Microphone button to turn it on or off. Note 

that if you have a half-duplex sound card, and you select Hands Free mode and turn 

your microphone on, your speaker will be turned off. This is because with a 

half-duplex sound card, your microphone and speaker cannot be turned on at the same 

time. You will need to turn your microphone off in order to receive audio, or switch to 

Push To Talk mode. 

Using Your Microphone in Push To Talk Mode
If you are in Push To Talk mode, you must click and hold the microphone button in 

order to transmit audio. This is the recommended mode if you have a half-duplex 

sound card. To learn more about Hands Free and Push To Talk modes, see “Audio 

Modes” on page 4-29.

Squelch Echo reduction

Your microphone

Your speaker

Microphone volume level

Speaker volume level

on/off switch

on/off switch
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Adjusting Audio Levels
Use the volume sliders (shown in Figure 4-14) to raise and lower the level of sound 

being sent from your microphone and being played through your speakers. Move the 

sliders to the right to increase the levels and to the left to decrease the levels. The level 

indicators show the level of sound being sent or received.

If you are in Hands Free mode, you will see a red triangle above the microphone level 

indicator (see Figure 4-14). This is the Squelch control and it is only displayed when 

you are in Hands Free mode. This control sets the minimum level for sound to be sent 

from your microphone when you are not receiving audio. Any sound below this level 

will not be transmitted. Drag the Squelch control to the right to raise the minimum 

level of sound that you will transmit. This can be useful when there is background 

noise in your environment. You can adjust the squelch level so that the background 

noise is not transmitted. 

If you are in Hands Free mode and you have Echo Reduction turned on, you will also 

see a green triangle above the microphone level indicator (see Figure 4-14). This is the 

Echo Reduction control. Echo Reduction is similar to Squelch control, except that it 

works when you are receiving audio. When you are receiving audio and sending audio 

simultaneously, the Echo Reduction control can prevent your microphone from 

sending sound that is coming from your speakers. Dragging the Echo Reduction 

control to the right will raise the minimum level of sound that you will transmit. Echo 

Reduction will also eliminate feedback, which can occur if your microphone is placed 

near your speakers. 

When you are sending audio above the minimum level, then your audio is actually 

being sent on the network and others can hear you. When your audio is being 

transmitted, you will see an animated sound wave appear next to the microphone level 

indicator, as shown in Figure 4-14.

Sending audio and video simultaneously takes a large amount of bandwidth. If you are 

using a low bandwidth connection, such as a modem, you can freeze your local video 

window to increase the amount of bandwidth available for sending audio. To do this, 

right-click on your local video window. Then click Freeze Video. A ✓ appears, 

indicating that your video is frozen. Click it again when you want to return to sending 

full-motion video.
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Status Bar
The Status Bar, located at the bottom of the Conference Room window, provides tips 

and information about your current status. For example, when you click and hold on a 

toolbar button, the Status Bar presents information about that button. When you pause 

your mouse pointer on a menu command, the Status Bar presents information about 

that command. In addition, the Status Bar tell you how long you have been connected 

to the current conference.
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Getting Information About a Participant
You can get information about a participant in a conference. One way is to get a 

participant’s Contact Card, which provides you with contact information about that 

person. To learn how to do this, see “Exchanging Contact Cards” on page 4-36. You 

can also get information about a participant’s software version, codecs, network 

connection, and more in a separate floating window, called the Info window.

To display the Info window:

1. Using the right mouse button (right-click), select a video window or a name in the 
Participants list. A dialog box appears. Click Info.

2. The Info window is displayed, as shown in Figure 4-15. Click on any of the four 
tabs in the Info window to see the following information about the selected 
participant:

• The version of CU-SeeMe 

• The audio and video codecs 

• Whether the participant is sending video, looking at you, hearing you, and can 
send audio

• Sending and receiving statistics (maximum, minimum, and current 
transmission and reception rates; packet loss; and frame rate measured in 
frames per second)

Figure 4-15. You can get information about a participant’s software and network
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3. Click on another video window or name in the Participants List. The Info window 
changes to display information about the new participant that you selected. 

4. Click the close button to close the Info window.
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Exchanging Contact Cards
A Contact Card is like a business card or a card in a rotary file. It is a convenient way 

to present and store information about a person or place, including contact 

information. Some users of CU-SeeMe have created Contact Cards about themselves. 

You can get Contact Cards from these people electronically and add these cards to 

your Phone Book. This will enable you to store contact information about these people 

and call them directly from your Phone Book. 

When you created a Personal Profile, you also created a Profile Contact Card. Just as 

you can get the Contact Cards of other users, they can get your Contact Card. If you 

choose to videoconference on public conferences, your Profile Contact Card can be 

seen and saved by anyone with CU-SeeMe; therefore, you should be careful what 

information you choose to display on your Profile Contact Card. For example, if you 

do not want strangers to have your phone number, then you should not list it on your 

Contact Card. 

To get a contact card from a participant:

1. On the Conference menu, point to Get Contact Card of. This displays a list of 
all the participants who have Contact Cards.

2. Point to the name of the participant you want to select, then click.

3. The Contact Card of the selected participant is now displayed in a separate 
window, as shown in Figure 4-16.

Figure 4-16. You can get a Contact Card from another CU-SeeMe user
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4. If you want to save the card, click Save. This will save the Contact Card in your 
Phone Book. You can change the Nickname for the card (as it will appear in your 
Contact Card list) and you can assign it to a Contact Group. For more information 
see “Contact Groups” on page 3-12.

5. Click OK. 

To find out how to create your own Contact Card that can be shared with others see 

“Creating a Personal Profile” on page 3-22.
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Disconnecting From a Conference
When you are ready to leave a conference, you can disconnect from the conference in 

one of 2 ways.

To disconnect from a conference:

◆ On the Conference menu, click Hang Up.

- or -

◆ Click the Hang Up button on the toolbar.

This will disconnect you from the current conference. The Conference Room window 

will close automatically and the Phone Book window will appear. You can exit the 

application by choosing Exit from the File menu in the Phone Book. Or you can use 

the Phone Book to connect to other conferences. To learn more about using the Phone 

Book, see Chapter 3.
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Chapter 5

Using the 
WhitePineBoard

WhitePineBoard is the document conferencing component of CU-SeeMe. It can be 

used for document review, business presentations, online training, and more. You 

can share documents and graphics so that multiple people can work on the same files 

at the same time from remote sites. The WhitePineBoard provides Workbooks that 

allow you to easily share your images and documents. Any participant in the 

conference can mark up images, highlight important items in the WhitePineBoard, 

or transfer files to all or selected participants without disturbing the conference. The 

Synchronized Scroll and Common Frame features ensure that participants are 

always viewing the same information at the same time.

When you are in a CU-SeeMe conference and want to share your files with other 

remote users, you open a WhitePineBoard Workbook. A Workbook is a collection 

of Pages contained in a file with the extension .fst. Each Page in a Workbook is a 

window that displays the information you want to share, such as a picture, a 

document, or a chart.
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Starting WhitePineBoard
You can use WhitePineBoard in a point-to-point conference and in a group 

conference. See “CU-SeeMe Conference Types” on page 1-7 for more information 

about point-to-point and group conferences.

The WhitePineBoard included in this version of CU-SeeMe is only compatible with 

CU-SeeMe Version 3.0 and later. This means that you will be able to share 

WhitePineBoard Workbooks with other users with CU-SeeMe Version 3, but not with 

users running earlier versions.

Sharing in a Point-to-Point Conference
A point-to-point conference occurs when one person conferences directly with another 

person. 

To use WhitePineBoard in a point-to-point conference:

1. Click the WhiteBoard button on the Conference Room toolbar. This opens the 
WhitePineBoard window, which is described in“WhitePineBoard Window” on 
page 5-6.

2. Note that you have opened the WhitePineBoard window on your computer screen 
only. The person to whom you are connected will also need to open 
WhitePineBoard on his/her computer.

3. To begin sharing information, you or the other person need to share a workbook. 
See “Opening and Sharing a Workbook” on page 5-13.

Sharing in a Group Conference
A group conference occurs when multiple people are connected to a separate computer 

running conference server software. Newer versions of conference server software 

include Net.120, which is a component of the server that centralizes data streams and 

allows for a more stable and higher-performing WhitePineBoard session. You can 

conference with WhitePineBoard whether or not you are connected to a conference 

server supporting Net.120, however, there are some differences which are noted in the 

following steps.You do not need to know whether the conference server to which you 

are connected conforms to Net.120 standards. The conference server will present you 

with the correct information.
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To use WhitePineBoard in a group conference:

1. Click the WhitePineBoard button on the Conference Room toolbar. 

2. On a conference server with Net.120:

A dialog box appears. Click Interactive to create a WhitePineBoard where all 
participants can contribute and interact. Click View-Only to create a 
WhitePineBoard where you are the only person who can change the contents, and 
everyone else can view your WhitePineBoard. Click Cancel to cancel the 
WhitePineBoard. 

Note that you have opened the WhitePineBoard window on your computer screen 
only. Other participants in the conference can join your WhitePineBoard session 
by clicking the WhitePineBoard button on their Conference Room toolbars. This 
will present them with the same dialog box and will then open WhitePineBoard 
windows on their screens. To begin sharing information, you or the other 
participants need to share a workbook. See “Opening and Sharing a Workbook” 
on page 5-13.

If the person who started the WhitePineBoard session disconnects from the 
conference or closes the WhitePineBoard, the WhitePineBoard session will 
continue to exist for the remaining participants. This is an advantage offered by 
Net.120.

3. On a conference server without Net.120:

A dialog box appears listing existing WhitePineBoard sessions from which to 
choose. It also offers the option of creating your own WhitePineBoard session.

Note that you have opened the WhitePineBoard window on your computer screen 
only. Other participants in the conference can join your WhitePineBoard session 
by clicking the WhitePineBoard button on their Conference Room toolbars. This 
will present them with the same dialog box and will then open WhitePineBoard 
windows on their screens. To begin sharing information, you or the other 
participants need to share a workbook. See “Opening and Sharing a Workbook” 
on page 5-13.

If the person who started the WhitePineBoard session disconnects from the 
conference or closes the WhitePineBoard, then the entire session is closed.
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Ending a WhitePineBoard Session
A conference participant may leave a WhitePineBoard session at any time; however, 

in some cases, if the person who started the session leaves, the session is over (see “To 

use WhitePineBoard in a group conference:” on page 5-3). In a point-to-point 

conference, if one person leaves the WhitePineBoard session, the session ends.

To end a WhitePineBoard session:

1. Click on the Leave Conference button (or click on the Conference menu, then 
on Leave). When a message appears asking if you are sure you want to leave the 
conference, click on Yes. Another message box appears asking if you want to 
retain copies of the shared Workbooks.

2. If you do not want to retain copies of the shared Workbooks, click on No and leave 
the conference.

3. If you want to retain shared Workbooks on your computer or network, click on 
Yes. You leave the conference, but the Workbooks remain open and are converted 
to private Workbooks. To save the Workbooks, see “Saving and Naming a 
Workbook” on page 5-20.
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Sharing Information with WhitePineBoard
There are two basic ways to share information with WhitePineBoard:

◆ Use Workbooks and Pages

◆ Use File Transfer

Workbooks and Pages
When you are using WhitePineBoard and want to share your files with other remote 

users, you open a Workbook. A Workbook is a collection of Pages contained in a file 

with the extension .fst. Each Page in a Workbook is a window that displays the 

information you want to share, such as a picture, a document, or a chart. To learn more 

about Workbooks, see “Opening and Sharing a Workbook” on page 5-13.

File Transfer
WhitePineBoard allows you to send actual files to all or selected participants during a 

conference. The transfer does not interrupt the conference because it takes place in the 

background. To learn more about file transfer, see “Opening and Sharing a Workbook” 

on page 5-13.

For more information on how to share information with WhitePineBoard, see the 

online Help.
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WhitePineBoard Window
The WhitePineBoard window, shown in Figure 5-1, contains the Menus, Toolbars, and 
the Status Bar. The workspace in the center is used to hold WhitePineBoard Workbooks.

Figure 5-1. A sample WhitePineBoard window

Using the Menus
The Menus are located just below the WhitePineBoard Title Bar. When you have a 

Workbook open, all of the menus appear. The menus are: File, Edit, View, Insert, 

Style, Conference, Window, and Help. When you click on a menu, it drops down to 

reveal commands that can be selected with a click of the mouse button. A command 

that appears dimmed is not available for use, usually because the operation is not 

appropriate at the time.

Using Toolbars
Toolbars contain buttons that enable you to select frequently used commands quickly. 

The permanent toolbars in the WhitePineBoard window are:
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◆ Standard Toolbar—Buttons to open, save, and print Workbooks, edit objects, 
use Full Screen, sort and zoom Pages, as well as create a WhitePineBoard 
conference, invite participants, and join and leave a WhitePineBoard conference 
(see Figure 5-2).

Figure 5-2. The WhitePineBoard Standard Toolbar

◆ Drawing—Buttons to select and highlight objects, draw lines, ellipses, 
rectangles, enter text, and turn on a Conference Pointer that can be seen by remote 
users (see Figure 5-3).

Figure 5-3. The WhitePineBoard Drawing Toolbar

◆ Navigation—Buttons to change Pages quickly, moving to the first, previous, 
next, or last Page. To view any other Page, click on Jump to Page. In the Jump 
dialog box, click on the number of the Page you want to view, then click on OK 
(see Figure 5-4).

Figure 5-4. The WhitePineBoard Navigation Toolbar

◆ Full Screen—Buttons to change Pages quickly, select and highlight objects, draw 
freehand, turn on a Conference Pointer, and return to the WhitePineBoard main 
window (see Figure 5-5). This toolbar appears only after you select the Full 
Screen command.

Figure 5-5. The WhitePineBoard Full Screen Toolbar

Point to each toolbar button and read the Status Bar to find out what the tool does.
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Moving a Toolbar

To move a toolbar to a more convenient location, follow this procedure:

1. Place the tip of the mouse pointer on the Title Bar or gray non-button area of the 
toolbar.

2. Click and hold down the left mouse button while you drag the toolbar to a new 
location.

3. Release the mouse button to drop the toolbar.

To dock a toolbar (send it to the top of your window), double-click on its Title Bar or 

drag it to the top of the window. To undock a toolbar, drag it off the dock area or 

double-click anywhere on the gray non-button area.

Resizing a Toolbar

Click on the toolbar frame and drag to resize the toolbar so that it is vertical or 

horizontal.

Restoring a Lost Toolbar

If you click on the Control-menu box in the upper left corner of a toolbar, the toolbar 

disappears. To restore it, follow this procedure:

1. Click on the View menu, then on Toolbars. The Toolbars dialog box appears.

2. In the Toolbars list, click on the name of the toolbar that disappeared and then on 
OK. The toolbar reappears on your screen.
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Turning a Toolbar Off and On

You can turn off a toolbar to have more viewing space.

1. Click on the View menu, then on Toolbars. The Toolbars dialog box appears, as 
shown in Figure 5-6.

Figure 5-6. The WhitePineBoard Toolbars dialog box lets you customize your view of Toolbars

2. In the Toolbars list, click on the box next to the toolbar you want to turn off. The 
✓ in the box is removed.

3. Click on OK. The toolbar no longer appears on your screen. 

To turn a toolbar on, repeat these steps, except click on the empty box to place the ✓ 

next to the toolbar you want to turn on.

To learn another way to turn a toolbar off, use the right mouse button to click on either 

the Title Bar or the gray non-button area of any toolbar. A shortcut menu appears. 

Click on the name of the toolbar you want to turn off.

Status Bar
The Status Bar displays the following information:

◆ The name of the current Page.

◆ Informational messages, such as a description of a tool or menu command when 
you point to it.

◆ Error messages.
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◆ A light that indicates that a conference is in progress. (A yellow light appears after 
you create a conference; a green light appears when there are two or more 
participants.)

◆ The number of participants in a conference.

◆ The time elapsed since creating or joining a conference.

◆ The current Zoom level.

◆ The current time.

Turning the Status Bar Off and On

Click on the View menu, then on Status Bar. The check mark is removed and the 

Status Bar no longer appears on your screen. To turn the Status Bar on, click again on 

the View menu, then on Status Bar.

It is best to keep the Status Bar turned on so that important information is always 

visible. 
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Transferring a File
WhitePineBoard allows you to send files to all or selected participants during a 

WhitePineBoard conference. The transfer takes place in the background and does not 

interrupt your conference. 

To transfer a file, follow these steps:

1. Click on the Transfer File button (or click on the File menu, then on Transfer). 
The File Transfer dialog box appears as shown in Figure 5-7.

Figure 5-7. The File Transfer dialog box allow you to select files and recipients

2. By default, all conference participants are listed in the Receiving Files box. If you 
do not want to send a file to a participant, double-click on the name and it is moved 
to the Not Receiving Files box. Use the Add, Remove, Add All, and Remove All 
buttons to move selections from one box to the other.

3. When the list of recipients is satisfactory, click on the Add Files button. The 
Select File(s) to Transfer dialog box appears. 

4. Select the drive and directory that contain the file(s) and then select the file.

To select more than one file, hold down the SHIFT key and click on several file 
names, or hold down the CTRL key and click on non-adjacent file names.

5. Click OK. The File Transfer dialog box returns and the file name(s) appears in the 
Files list. 

6. Click OK. The file(s) is compressed if you requested compression in the 
Preferences dialog box. The File Transfer Acceptance dialog box appears.
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7. Use the numbers next to the three status messages to determine how many 
recipients have accepted, declined, or not responded to the transfer. After 
everyone accepts, or if you decide not to wait for a recipient, click on the Transfer 
Now button to transfer the files. If you change your mind, click on the Abort 
Transfer button. 

8. After you send a file, the Sending Files dialog box displays the file transfer 
progress.

Receiving a Transferred File
When files are sent to you, follow these steps:

1. The Receive Files dialog box appears on your screen listing the file(s) offered (if 
you have not turned on Always Accept Files Sent to You in the Preferences dialog 
box).

2. Click No if you do not want to receive the file(s). The dialog box disappears.

3. To send file(s) to another directory, click on the Receive File(s) Directory button. 
The Receive File(s) Directory dialog box appears. Select the drive and directory 
where you want to store the file(s). Click on OK. The Receive Files dialog box 
reappears.

4. Press CTRL and click on any file(s) you do not want to receive. Click on Yes to 
receive the file(s) and have them sent to the Receive File(s) Directory. The 
Receiving Files dialog box displays the progress of the file transfer. 

5. After the file(s) arrives, check the directory to verify that it contains the file.
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Opening and Sharing a Workbook
The Workbooks you create for use in WhitePineBoard may be private (only you can see 
the Workbook) or shared (all conference participants can see the Workbook).

When you are connected in a WhitePineBoard conference, remote users can only see 
Pages in Workbooks that are designated as shared.

1. Click on the Open button (or click on the File menu, then on Open). The File 
Open dialog box appears.

2. Select the drive and directory that contain the Workbook.

3. Type or select the Workbook name in the File Name box. Click OK. The Share 
Workbook Now dialog box appears, as shown in Figure 5-8.

Figure 5-8. You can choose to share a Workbook or keep it private

4. Click on the Share button. Leave your Conference User Name in the box, or enter 
another name and click on OK. 

The Title Bar of the shared Workbook has the following format on all of the 
participants’ screens:

Workbook Name - Filename.fst

At the end of a WhitePineBoard session, you can convert shared Workbooks to private 

Workbooks and save them as your own. For more information, see “Ending a 

WhitePineBoard Session” on page 5-4.

Private Workbooks have the word (Private) in the Title Bar so that participants can 

easily distinguish between shared and private Workbooks while in a conference.

Select this for a
private Workbook
Select this for a
shared Workbook

If Share is selected,
type name of Workbook 
as it will appear to others
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Active Workbook
While in a WhitePineBoard conference that has two or more shared Workbooks, only 

one Workbook is active (in focus) at any time. The Active Workbook focus is 

synchronized among all conference participants. Any conference participant may 

change the Active Workbook focus. If you open a private Workbook, it is not affected 

by the Active Workbook. When you are ready to return to the conference flow, click 

on the Window menu, then on Active Workbook. The focus on your screen shifts 

automatically to the Active Workbook.

Sharing a Private Workbook
You can change a private Workbook to a shared Workbook at any time.

To share a private Workbook:

1. Click on the Share Workbook button (or click on the Conference menu, then on 
Share Workbook). The Shared Workbook Title dialog box appears.

2. Enter a name in the box and click OK. The Workbook is shared, and the same 
name appears in the Workbook Title Bar on the remote users’ screens and on your 
own.
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Using Full Screen View
Use Full Screen when you want the Pages in your Workbook to appear as large as 

possible.

To use Full Screen view:

1. With a Workbook open, click on the Full Screen button (or click on the View 
menu, then on Full Screen). The WhitePineBoard window features disappear and 
the current Page is centered and expanded to its maximum size. The Full Screen 
Toolbar appears.

2. Move the Full Screen Toolbar to a convenient location. The next time you select 
Full Screen, the toolbar will appear in the location where you left it.

3. To turn off the Full Screen Toolbar, click the right mouse button, then click on 
Hide Toolbar.

4. To turn the Full Screen Toolbar on, click the right mouse button, then click on 
Show Toolbar.

5. When you are ready to return to the main WhitePineBoard window, click on the 
Full Screen button on the Full Screen Toolbar. You can also press ESC. The 
WhitePineBoard window returns.
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Using Common Frame
Use Common Frame to see an outline surrounding the area viewed by all conference 

participants. This feature is extremely useful because screen resolutions can vary. 

To turn on Common Frame:

Click on the Common Frame button. (Or, click on the View menu, then on Common 
Frame. A ✓ appears to indicate that Common Frame is on.) 

A frame indicating the size of the remote user’s Workbook appears (see Figure 5-9). 

If your Workbook is the smallest, the frame appears around its border. The Common 

Frame may change if any participant changes Workbook sizes.

Figure 5-9. The Common Frame highlights the area viewed by all conference participants

To turn off Common Frame:

Click on the Common Frame button. (Or, click on the View menu, then on Common 
Frame.) The ✓ is removed, indicating that Common Frame is off.

Common Frame is only available during a WhitePineBoard session. It is a local 

function that does not affect remote users, unless they turn it on themselves.

Common Frame
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Pointing With the Conference Pointer
After the WhitePineBoard session is underway, you might want to point to a particular 

area or item on a Page. If you point with your normal mouse pointer, remote users will 

not see it, but they can see the Conference Pointer.

Using the Conference Pointer:
1. To activate the Pointer, click on the Conference Pointer in the Drawing Toolbar. 

The Pointer appears, replacing your normal mouse pointer.

2. Change the shape of the Pointer to suit your purpose. Click on the Style menu, then 
on Pointer Shape. The available Pointer styles appear. Click on the one you want. 
The Pointer will be visible on the remote users’ screens and can be used to indicate 
any item in a Workbook.

Closing the Conference Pointer

Point to any other tool on the Drawing Toolbar and click. The Pointer changes to the 

normal mouse pointer.
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Annotating During a WhitePineBoard Session
Use the Drawing Tools to mark up, or annotate, your Pages during a WhitePineBoard 

session. For example, if you have a map on a Page, you can draw the route using the 

Freehand Tool located on the Drawing Toolbar. See “Using WhitePineBoard Objects” 

on page 5-32 for information about drawing objects and entering text.

The Drawing Tools are: 

◆ Highlighter Tool

◆ Freehand Tool

◆ Line Tool

◆ Ellipse Tool

◆ Rectangle Tool

◆ Text Tool

Remember, the annotations you make are actual objects. You can adjust their 

attributes, move, resize, cut, copy, paste, or delete them. During a conference, 

everything you draw on the Page is seen by the other remote users.

In a group conference, each participant can annotate with a different color to avoid 

confusion.
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WhitePineBoard Workbooks
The image (such as a picture, a document, or a chart) that you want to share with a 

remote user must be contained in a special window called a Page. Pages are grouped 

together for convenience and stored in a Conference Workbook.

Shared and Private Workbooks
All Workbooks that you have just opened or created are private, or unshared, by 

default. You may choose to keep a Workbook private for various reasons, such as to 

withhold an announcement until the proper time, or to preserve proprietary or financial 

information. Private Workbooks have (Private) in the Title Bar.

During a WhitePineBoard session, remote users can only see the images on your Pages 

if you share your Workbook with them. By sharing a Workbook, you allow remote 

users not only to view and discuss the Pages, but also to perform the following 

procedures:

◆ Select Pages by clicking on Page tabs

◆ Use the annotation tools on the Drawing Toolbar to mark up the images on Pages

◆ Add new blank Pages

◆ Delete Pages

◆ Move Pages to and from other Workbooks

◆ Save the shared Workbook and name it

◆ Print the shared Workbook

Workbooks must be deliberately shared during a WhitePineBoard session. After the 

session is ended, the Workbooks that you shared become unshared, or private, again. 

See “Opening and Sharing a Workbook” on page 5-13 for more information.

Creating a New Workbook
Click on the New Workbook button (or click on the File menu, then on New). A new 

empty Workbook appears.
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When you create new Workbooks, WhitePineBoard assigns consecutive numbers to 

them (such as Workbook 1, Workbook 2). To give your Workbook a more meaningful 

name, use the procedure below for saving and naming a Workbook.

Selecting a Workbook
You must select a Workbook before you can perform any procedures on it. To select 

a Workbook, click on its Title Bar. The color of the Title Bar changes to show that the 

Workbook is selected.

Saving and Naming a Workbook
Use this procedure to save a Workbook you have created or to save any Workbook 

shared during a WhitePineBoard session as your own copy.

1. Click on the Workbook’s Title Bar to select it. Click on the File menu, then on 
Save As. The File Save As dialog box appears.

2. Select the drive and directory where you want to store the Workbook.

3. Type a name in the File Name box. The name should be no more than eight 
characters long and be followed by the extension .fst. If you do not type the 
extension, WhitePineBoard does it for you.

4. Enter a description of the file if you desire. (The description appears when you 
open the file later.)

5. Click OK. The Workbook is saved under the name you gave it.

Saving a Workbook
Use this procedure to save a previously named Workbook.

◆ Click on the Workbook’s Title Bar to select it. Click on the Save button,

- or -

◆ Click on the Workbook’s Title Bar to select it. Click on the File menu, then on 
Save. Your Workbook is saved with its existing name.
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Arranging Workbooks
During a WhitePineBoard session, you may want to work with several Workbooks at 

the same time. Depending on your purpose, Workbooks may be arranged on the screen 

in three ways:

◆ Click on the Window menu, then on Tile Horizontal. This maximizes Workbook 
width.

◆ Click on the Window menu, then on Tile Vertical. This maximizes Workbook 
height.

◆ Click on the Window menu, then on Cascade. This overlaps Workbooks, but you 
can see each Title Bar.

Your window arrangement does not affect the arrangement of Workbooks on the 

remote users’ screens.

Closing a Workbook
If you have made changes to a Workbook, save the Workbook before closing it. To 

close a Workbook, click on its Title Bar to select it. Click on the File menu, then on 

Close.
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WhitePineBoard Pages
Pages are the special windows that contain the images you want to share. Pages are 

stored in a Workbook and can be viewed by clicking on the Page tabs at the bottom of 

the Workbook. The names of the Pages are shown on the tabs and on the left side of 

the Status Bar.

Whenever you make changes to a Page, you should save the Workbook that contains 

the Page if you want to keep those changes.

Selecting a Page
You must select a Page before you can perform procedures on it or on the objects or 

images it contains. To select a Page, click on its tab. The tab lightens to show that the 

Page is selected.

Inserting a new Page
To insert a new Page in a Workbook, follow this procedure:

1. Decide which Page will be directly in front of the new one and click on its tab.

2. Click on the Insert New Page button (or click on the Insert menu, then on New 
Page). The new Page appears.

Renaming a Page
To change the name of a Page, follow this procedure:

1. Click on the Page’s tab to select it.

2. Click on the Edit menu, then on Rename Page. The Rename Page dialog box 
appears.

3. In the Name box, type the new name over the existing name. Click OK. The new 
name appears on the Page tab, the Status Bar, and in the Page Sorter label.

Zooming a Page
To display an enlarged or reduced version of a Page, follow this procedure:

1. Click on the Page’s tab to select it.
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2. Click on the Set Zoom button (or click on the View menu, then on Zoom). The 
Zoom Level dialog box appears.

3. Select the level of magnification you want, or type a precise percent (between 10 
and 1000) in the Custom box. Turn on the Zoom All Pages option if you want all 
Pages in your Workbook reduced or enlarged.

4. Click OK. The image changes to the magnification level you have chosen.

5. The normal size of an image is displayed when it is viewed at 100%. Images are 
always saved at this level.

Printing a Page
1. Select the Workbook that contains the Pages you want to print by clicking on the 

Workbook’s Title Bar.

2. Click on the Print button (or click on the File menu, then on Print). The Print 
dialog box appears.

3. To print a Page(s), make sure that Workbook Pages is selected in the drop-down 
list box. To print handouts (2-6 images per page), click on the drop-down list box 
and select the number of images you want.

4. In the Print Range box, click on either All Pages, Current Page, or Pages. If you 
select Pages, you can print a single Page by entering the Page number in both the 
From and To boxes. To print a range of Pages, type the first Page number in the 
From box and the last Page number in the To box.

5. Complete the other boxes in the Print dialog box.

6. To see how your printout will look, click on the Preview button. When you are 
finished, click on the Print button to return to the Print dialog box.

7. Click OK. It may take a few minutes for your Page(s) to print, especially if it 
contains a complex image.

Exporting a Page
To save a Page in a format that can be imported by other applications, follow this 

procedure:

1. Click on the desired Page.

2. Click on the File menu, then on Export Page. The Export Page As dialog box 
appears.
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3. Select the drive and directory containing the file you want to export.

4. Click on the down arrow in the List Files of Type box and select the type of file 
that you want to export, such as .pcx or .tif.

5. Type a name in the File Name box and add the appropriate extension. 

6. Select the number of colors that you want the exported image to have. Click OK.

Clearing a Page
To clear a Page of all objects, including text objects, and leave the empty Page in the 

Workbook, follow this procedure.

1. Click on the Page’s tab.

2. Click on the Edit menu, then on Clear. A cascading menu appears.

3. Click on Active Page. The Page is cleared of all objects, but it remains in the 
Workbook.

Deleting a Page
To remove a Page permanently from a Workbook, follow this procedure:

1. Click on the Page’s tab.

2. Click on the Edit menu, then on Delete Page. A dialog box appears.

3. Click on Yes to delete the Page. The Page disappears.

Use the shortcut menu to insert a new Page, rename, or delete a Page. Click the right 

mouse button on the Page tab to produce the shortcut menu, then click on the command 

you want to use.
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Working with Page Sorter
The Page Sorter displays thumbnail versions of the Pages in a Workbook, as shown in 

Figure 5-10). Using Page Sorter, you can easily insert and delete Pages, rearrange the 

Workbook, and move or copy Pages from one Workbook to another.

Figure 5-10. Page Sorter displays thumbnail versions of Pages in a Workbook

The name of each Page appears in a label below the thumbnail. To change the name, 

see “Renaming a Page” on page 5-22.

You may use Page Sorter during a WhitePineBoard session. Remote users will not see 

this window unless they also select Page Sorter. However, any changes you make 

while you are using Page Sorter (such as reordering or inserting Pages) will be 

received by remote users.

You may have one Page Sorter window for each Workbook that you have open.

Opening Page Sorter
1. Select the Workbook for which you want to see the Page Sorter thumbnails.

2. Click on the Page Sorter button (or click on the View menu, then on Page 
Sorter). Thumbnail versions of the Pages in your Workbook appear in a new 
window.

If you double-click on the thumbnail of a Page, the corresponding full Page image 

appears in the Workbook and the Sorter view stays selected.

Closing Page Sorter
Close the Page Sorter window by double-clicking on the Control-menu box (or click 

on the Control-menu box, then on Close).
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Selecting Pages in Page Sorter
Before you can work with a thumbnail Page in Page Sorter, the thumbnail must be 

selected. A selected thumbnail appears with a dark border around it. 

◆ Selecting one Page
Place the mouse pointer on a thumbnail and click. (Do not click on the thumbnail 
label.)

◆ Selecting two or more Pages
Click on one thumbnail, then hold down the SHIFT key and click on the others. 
Use the SHIFT key to select thumbnails that are not in consecutive order. 

◆ Using the Marquee method to select Pages
Click in the gray area near a thumbnail to produce the marquee, or selection 
rectangle. Hold the mouse button down and move the pointer to touch each 
thumbnail that you want to select.

Clicking on a thumbnail label or in the space between thumbnails will deselect all 

thumbnails. To deselect a specific thumbnail from a selected group, hold the SHIFT 

key down and click on the thumbnail with the mouse pointer.

General Procedures in Page Sorter
The following procedures are performed in Page Sorter just as they are in the normal 

Page view:

◆ Inserting a New Page (see “Inserting a new Page” on page 5-22)

◆ Renaming a Page (see “Renaming a Page” on page 5-22)

◆ Printing a Page (see “Printing a Page” on page 5-23)

◆ Deleting a Page (see “Deleting a Page” on page 5-24)

Moving Pages within a Workbook
If you do not like the order of the Pages in a Workbook, you can easily rearrange them 

in Page Sorter.

1. Select the Workbook and open Page Sorter.

2. Click on the thumbnail of the Page to be moved, hold down the mouse button, and 
drag the thumbnail to its new position.
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3. Release the mouse button to complete the move.

To move more than one Page at a time, select the thumbnail Pages using the SHIFT 

key or marquee method and drag them as a group. Release the mouse button when they 

are in the proper position.

Copying Pages Within a Workbook
To make a copy of a Page within a Workbook, follow this procedure:

1. Select the Workbook and open Page Sorter.

2. Click on the thumbnail of the Page to be copied, hold down the mouse button, 
press CTRL and drag the copy to the desired position.

3. Release the mouse button to place the copy.

Copying or Moving Pages to Another Workbook
To copy or move a Page to another Workbook with Page Sorter, follow this procedure:

1. Open one of the two Workbooks and open Page Sorter for it. Minimize the 
Workbook. Repeat for the second Workbook.

2. Click on a Page Sorter window to select it. Click on the Window menu, then on Tile 
Vertical. 

3. Click and hold the mouse button down on the thumbnail Page you want to copy or 
move. Drag the thumbnail from one Workbook to the other.

4. Release the mouse button when the thumbnail is in the new position. To copy or 
move more than one thumbnail at a time, select the thumbnails using the SHIFT 
key or marquee method and drag them as a group. 

5. To move a thumbnail Page instead of copying it, go back to the thumbnail Page in 
the original Workbook and delete it.
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Preparing WhitePineBoard Pages
Before conducting a WhitePineBoard session, it is helpful to plan your presentation 

and prepare a Workbook to be shared with remote users. Workbook Pages can be 

prepared by using any of the following methods: 

◆ Print Capture

◆ Screen Capture

◆ Insert Picture

◆ Video Capture

◆ WhitePineBoard Drawing Tools

Print Capture
Use this method to prepare Pages from a document in another Windows-based 

application. 

1. Open the Windows-based application and the document that you want to capture 
for use in WhitePineBoard.

2. Use the application’s Print Setup command to select WhitePineBoard Print 
Capture on DISK as your printer. Click OK.

3. Use the application’s Print command to print the file. Select the page(s) you want 
to print and click on OK.

4. In the dialog box that appears, enter the drive, directory, and file name for the 
Workbook in which you want to store the Pages.

5. When printing is completed, open WhitePineBoard and then open the Workbook 
to which you printed. If WhitePineBoard is already running, your captured image 
will display as the current Workbook.

6. Each page of your document that is denoted by a page break becomes a separate 
Page in the Workbook. If you print to an existing Workbook, you may choose to 
overwrite or append the Pages to the end of the Workbook.

Screen Capture
Use this method when you want to capture a screen image from another application.

1. If you want the captured image to appear on an existing Page, select the Page now; 
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otherwise, the default setting puts it on a new Page.

2. Click on the Insert Screen Capture button (or click on the Insert menu, then on 
Screen Capture). The WhitePineBoard window disappears and the floating 
Capture Toolbar appears, as shown in Figure 5-11.

Figure 5-11. The Capture Toolbar

3. Open the application of your choice and open or create the image you want to 
capture.

4. Click on the appropriate button in the Capture Toolbar to select the capturing 
method.

5. If you want to stop a screen capture operation, press the ESC key.

6. Click on the window you wish to capture, 

- or - 

Click and drag a rectangle around the portion of the screen to be captured. 

7. Release the mouse button to capture the image. A preview of the capture appears. 
If you want it on an existing Page, turn off the Insert as New Page box. If you are 
satisfied with the preview of the capture, click OK.

If you are not satisfied with the preview of the capture, click on the Cancel button 
and return to step 4.

8. After you have captured the image, the WhitePineBoard window reappears with 
the captured image on the Page you have chosen.

9. To capture the entire desktop, click on either the Capture a Window or Capture 
a Window without borders button. Then click on an empty area of the desktop 
to capture everything. 

Help

Return to Capture a
 rectangular region WhitePineBoard

Capture a 
window

Capture a window
without borders
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Insert Picture
Use this method when you already have a graphic image that you want to import, such 

as clip art or a diagram.

1. If you want the image to appear on an existing Page, select that Page now; 
otherwise, the default setting puts the image on a new Page.

2. Click on the Insert Picture button (or click on the Insert menu, then on Picture). 
The Insert Picture dialog box appears.

3. In the List Files of Type box, click on the format extension of the image that you 
want to insert. Table 5-1 lists the file formats supported by WhitePineBoard.

4. Click on the drive and directory that contain the file with the image.

5. In the File Name box, type or click on the name of the file with the image you want 
to insert. If you want the image on an existing Page, turn off the Insert as New 
Page box.

6. If your display is configured at 256 colors or less, leave the Limit Images to 256 
Colors option turned on.

7. Click OK. The image appears on the screen.

Table 5-1. You can insert pictures from these file types into WhitePineBoard

File type Used by these applications

.bmp (Windows Bitmap) Microsoft Windows

.dib (Device Independent Bitmap) Microsoft Windows

.pcx Paint and desktop publishing software

.tif (Tagged Image File Format) Desktop publishing and 
scanning software

.jpg (JPEG) Software for compressing photographic images

.tga (Targa files) Scanning and paint software

.pct (PICT) Macintosh computers

.eps (Encapsulated PostScript) PostScript printers

.wpg (WordPerfect Graphic File) WordPerfect

.wmf (Windows Metafile Format) Microsoft Windows
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WhitePineBoard Drawing Tools
Use the built-in WhitePineBoard Drawing Tools on the Drawing Toolbar to create a 

Page of your own design. For example, you might want to type a conference agenda 

directly on the first Page in a Workbook. You can draw directly on a Page and combine 

your objects with other images. For information about working with objects, see 

“Using WhitePineBoard Objects” on page 5-32.
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Using WhitePineBoard Objects
An object is any text or graphic that is placed on a Page, including graphic images 

imported from another application. 

The following procedures will help you work with objects both before a 

WhitePineBoard session, when you are preparing Workbooks, and during a session, 

when you are annotating shared Workbooks.

Creating Objects
You can create objects by using the Drawing Tools on the Drawing Toolbar.

Drawing an object

1. On the Drawing Toolbar, click on the Drawing Tool of your choice: Line, Ellipse, 
Rectangle, or Freehand. These tools, along with the Text Tool and the 
Highlighter Tool, are used to mark up, or annotate, the images on your Pages.

2. Position the pointer where you want to start drawing.

3. Hold down the left mouse button and drag to draw the object.

4. Release the button to complete the object.

5. You may continue to draw separate objects with the same tool, or click on the 
Select Tool to stop drawing.

You can create a square with the Rectangle Tool, or a circle with the Ellipse Tool, by 

holding down the SHIFT key while drawing.

Entering text

1. On the Drawing Toolbar, click on the Text Tool.

2. Place your cursor where you want to begin typing and click the mouse button. 
(The pointer changes to an I-beam.)

3. Type the desired text. Since text does not wrap, use the ENTER key to start each 
new line of text. Use the arrow keys to move around within the text.

To select text, use the Select Tool. See “Selecting objects” on page 5-33.
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Selecting objects
Before you can work with objects, including text objects, they must be selected. A 

selected object has resize handles, or black squares, around it.

Selecting a single object

1. Click on the Select Tool on the Drawing Toolbar. The pointer changes to the 
Select pointer.

2. Place the pointer on the object and click the left mouse button. Resize handles 
appear around the object.

Selecting a group of objects

1. Click on the Select Tool on the Drawing Toolbar. The pointer changes to the 
Select pointer.

2. Hold down the SHIFT key as you click on each object you want to select. Resize 
handles appear around each object as it is selected.

You can also select a group of objects by placing the pointer outside all the objects, 

pressing the left mouse button, and dragging a selection rectangle (or marquee) over 

all the objects you want to select. 

Selecting all objects on a Page

Click on the Edit menu, then on Select All.
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Changing Attributes of Objects
You may want to change the color, line width, fill pattern, or font of the annotation 

objects you create. Follow this basic procedure:

1. Select the object or objects you wish to change.

2. Click on the Style menu, then on the attribute you want to change, such as Line 
Width (see Figure 5-12).

Figure 5-12. You can change attributes of objects, such as line width

3. Click on the new attribute. The selected object(s) changes to reflect your choice.

Changing the color of text

1. Click on the Style menu, then on Font. The Font dialog box appears.

2. Click on the down arrow in the Color box. The drop-down color list appears.

3. Click on the color you want, then click OK.

Moving Objects
Click on the object and hold the mouse button down. Drag to move the object around 

the Page. Release the mouse button when the object is in the desired location.

Resizing Objects
Select the object, then click on a resize handle and drag to reduce or enlarge the object.

To resize text, select it, click on the Style menu, then on Font. Click on the point size 

you want, then on OK.
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Clearing Objects
Objects are deleted with the Clear command. Cleared objects are not placed on the 

clipboard and cannot be reinserted on a Page.

Clearing one object

1. Select the object that you want to delete.

2. Click on the Edit menu, then on Clear. A cascading menu appears. 

3. Click on Selection. The selected object is removed.

Clearing all objects

1. Click on the Page’s tab.

2. Click on the Edit menu, then on Clear. A cascading menu appears. 

3. Click on All Annotations. All objects are deleted.

Rearranging Stacked Objects
You may want to change the stacking order of objects if they are created on top of other 

existing objects, or if an image has been inserted on a Page that already contained 

another object.

Placing a particular object in front or back

1. Select the object you want to relocate.

2. Click on the Edit menu, then click on Bring to Front or Send to Back. The object 
is moved to the front or back of the stack.
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Cutting, Copying, and Pasting Objects
You can cut (remove), copy, and paste objects by using the clipboard, a temporary 

holding area for text objects and graphics. A copy of an object can be pasted on the 

same Page as the original or on another Page. 

Cutting an object

1. Select the object.

2. Click on the Cut button (or click on the Edit menu, then on Cut). The object is 
removed from the Page and placed on the clipboard. (Any information currently 
on the clipboard is replaced.)

Copying an object

1. Select the object.

2. Click on the Copy button (or click on the Edit menu, then on Copy). The original 
object remains in place. A copy of the object is placed on the clipboard.

Pasting an object

Follow this procedure to paste an object that has been cut or copied from a Page:

1. Select the Page that is to receive the object. (Click on the Page’s tab.)

2. Click on the Paste button (or click on the Edit menu, then on Paste). The object 
is moved from the clipboard to the Page.

If you copy an object to the same Page, the object appears exactly on top of the original 

object. Click on the copy and drag it to the desired position.
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Chapter 6

Configuring Your System

You can use CU-SeeMe on any IP-based network or connection and on many types 

of computers. The performance of your system will depend on many factors, 

including the type of communication channel you are using (such as a modem, an 

ISDN line, an Ethernet connection, and so on), the processing speed of your 

computer, and the number of video windows simultaneously displayed on your 

screen.

There are steps you can take to configure and customize your CU-SeeMe software 

to get the best possible videoconference experience. Some of these steps are 

explained in this chapter. Other information is available in online Help and in the 

Frequently Asked Questions (FAQs) on the CU-SeeMe Web pages at 

http://support.cuseeme.com.
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Choosing a Video Codec
CU-SeeMe uses special codec (COmpressor/DECcompressor) software to compress 

and decompress your video (or audio) data so that it can be sent more efficiently across 

a network. You can choose among several video codecs to best work with your 

network connection and the type of computer you are using.

CU-SeeMe lets you choose from 4 video codecs:

◆ White Pine M-JPEG

The Motion JPEG (or M-JPEG) codec offers high quality video on local area 
networks (LANs) and ISDN (or higher) network connections. It will also work 
with modems, however lower quality settings (15% to 25%) are recommended. It 
works with 8-bit, 16-bit, and 24-bit input (sometimes referred to as high color or 
true color). If you have any difficulty using M-JPEG, you should choose the 
White Pine Color or Cornell CU-SeeMe Gray codec instead of M-JPEG.

◆ White Pine H.263

This is a good codec for general use on local and wide area networks (LANs and 
WANs), however it uses more CPU power than the other codecs. This codec is not 
recommended for modem users as it will likely result in slow performance.

◆ White Pine Color

This codec can be used on LANs, WANs, and modems. It is the best choice for 
sending color video on a modem. The White Pine Color codec works well with 
most 24-bit capture devices with the exception of parallel port capture devices. 

◆ Cornell CU-SeeMe Gray

This codec only sends grayscale images. The other three let you send color images 
(if you are using a color camera). It is an excellent codec for modem users, as well 
as on LANs and WANs. You should choose this codec if your camera or capture 
device does not support color.
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Previous versions of CU-SeeMe did not include all of these video codecs. People using 

earlier versions of CU-SeeMe software will not be able to receive video sent with some 

of the newer codecs. Table 6-1 explains who can see your video image, depending on 

your choice of video codec.

To choose a video codec:

1. Click the Customize button on the Conference Room toolbar. Point to 
Configuration, then click. The Customize dialog box appears (with the 
Configuration tab displayed), as shown in Figure 6-1.

Figure 6-1. You can select a video codec to best fit your hardware and network setup

Table 6-1. Determining who can see your video image

If you are using this 
codec

These users will be able to see your video 
image

White Pine M-JPEG Any user with CU-SeeMe V3.0 or Enhanced 
CU-SeeMe V2.1.1. Currently, only Windows 95 
and NT users can see M-JPEG video images.

White Pine H.263 Any user with CU-SeeMe V3.0.

White Pine Color Any user with Enhanced CU-SeeMe V2.0 or 
higher or CU-SeeMe V3.0.

Cornell CU-SeeMe Gray Any user with any version of CU-SeeMe 
(including Cornell freeware).
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2. The video codec section is presented in the lower portion of the dialog box. Click 
the arrow next to the video codec to display a list of available codecs. Click on the 
name of the desired codec.

3. Click Configure. Some codecs allow you to make additional configuration 
settings and other codecs do not. For example, you cannot change configuration 
settings for White Pine M-JPEG and White Pine H.263 codecs.

4. The Quality slider is preset for each codec; however, you can adjust it manually. 
Note that Quality only affects the video that you send to others. It does not affect 
the video that you see displayed on your screen. Lowering the Quality setting 
sends a lower quality video image and sends less data. Therefore, a lower Quality 
setting will work better with a lower bandwidth network connection, such as a 
modem.

5. Click OK when done.

Changing Video Codec Settings
The best way to adjust a video codec is using the Test Setup feature in the Phone Book. 

This allows you to see your local and remote video images simultaneously so you can 

observe the effects of the changes you make. See “Test Your Setup” on page 6-13 for 

more information. You can also change video codec settings from the Conference 

Room while in a videoconference.

To change video codec settings in the Conference Room:

1. Click the Customize button on the Conference Room toolbar. Point to 
Configuration, then click. The Customize dialog box appears (with the 
Configuration tab displayed), as shown in Figure 6-1. 

2. Use the video codec Quality slider to increase the clarity of the video image you 
send. Higher Quality settings use more bandwidth and cause a longer time delay 
in your video picture. The higher the Quality setting, the more time delay there is 
between when you move and when the movement is seen by others. The Quality 
setting does not affect your local video window. Choose the lowest Quality setting 
that provides an acceptable remote video image. If you are using a modem, you 
will need to use a lower Quality setting than if you are using LAN or WAN.

3. When you have finished adjusting Quality, click OK.
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Recommended Settings for Each Video Codec
The best settings for each codec depend on a number of factors including your network 

connection. While there is no ideal setting for all conditions, recommendations are 

described below. They are intended as a starting point, however you may find that you 

need to adjust your settings from the recommended values.

Configuration refers to the Configure button shown in Figure 6-1. Quality refers to the 

slider, also shown in Figure 6-1, and described on page 6-4.

Settings for White Pine M-JPEG

Configuration

There is nothing to configure for this codec.

Quality

For a LAN or WAN, the recommended quality setting is between 25 and 65%. The 

settings are dependent on available bandwidth, your network connection, and the 

processing speed of your computer’s CPU. For a modem, the recommended setting is 

between 15 and 25%. See page 6-4 to learn how to adjust Quality.

Settings for White Pine H.263

Use this codec with 24-bit capture for best quality. This codec is not compatible with 

all video capture cards. If you have difficulty using this codec, switch to White Pine 

Color or White Pine M-JPEG.

Configuration

There is nothing to configure for this codec.

Quality

For a LAN or WAN, the recommended quality setting is between 20 and 40%. This 

codec is not recommended for modem users as it will result in slow performance. See 

page 6-4 to learn how to adjust Quality.
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Settings for White Pine Color

Configuration

1. Click Configuration. The Configure dialog box appears, as shown in Figure 6-2.

Figure 6-2. The White Pine Color codec features automatic settings

2. Select an automatic setting that matches your network connection: Modem, 
ISDN, or LAN. Then click OK.

3. Although the automatic settings work well for most users, you have the option of 
adjusting the codec manually. Using manual settings, you adjust the Compressor 
and Decompressor settings separately. (A codec includes both Compressor and 
Decompressor capabilities.)
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4. Click Compressor. The Manual SFM Compressor Settings dialog box appears, 
as shown in Figure 6-3.

Figure 6-3. The compressor in the White Pine Color codec can be adjusted manually

5. The options in the Manual SFM Compressor Settings dialog box are explained as 
follows:

• Internet Data Loss Recovery

Your video data is transmitted as a series of frames, which are updated 
continuously. In order to get the smoothest possible video with the least amount 
of data loss, the video codec looks at the changes from one video frame to the 
next, compresses this changed data, and then adds this data to the previous 
frame. The result is that the video image you transmit is updated as you move 
in front of your camera. Unfortunately, there is usually some unavoidable loss 
of data as your video image is sent across a network. To compensate for this 
loss and to make sure unwanted “noise” won't build up on the connection, a full 
frame (containing ten times more data than a typical frame which only includes 
the changes since the previous frame) is periodically distributed over a number 
of frames. A lower setting means that this full frame is inserted more often.

The default setting is 50%, which takes into account the amount of noise on a 
typical Internet connection. For connections over a LAN or WAN (considered 
a Good Connection) where there is much less noise, the rate of insertion can be 
increased, which means changing the setting to a lower number (or moving the 
slider to the left).
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• Camera/Capture Noise Reduction Filters

This option allows you to improve the video image from a lower quality 
camera. The default setting is None. If you see static or white spots in your 
local video image, change the setting to Median. If this doesn’t improve your 
video image sufficiently, change the setting to High.

Moving to a higher setting can sometimes cause your video image to appear 
blurry. If this happens, reduce your setting to at lower value (for example, 
change from High to Median, or Median to None).

• Lossless Options

Normal compression causes a loss of picture quality. Lossless options 
compensate for this.The term lossless means a perfect replication of a picture 
so that the picture, after it has been compressed and decompressed, is exactly 
the same as it was before entering this process. That is, no quality is lost in the 
picture. 

Luminance preserves brightness and contrast. Select Luminance if you are 
transmitting in grayscale. Chroma preserves colors. Select both Luminance 
and Chroma if you are transmitting in color.

Turning on lossless options uses more bandwidth so you may choose to turn 
them off if you are using a modem.

Quality 

For a LAN or WAN, the recommended quality setting is between 40 and 60%. For a 

modem, the recommended setting is between 10 and 30%. See page 6-4 to learn how 

to adjust Quality.

Settings for Cornell CU-SeeMe Gray

Configuration

There is nothing to configure for this codec.

Quality

For a LAN or WAN, the recommended quality setting is between 35 and 55%. For a 

modem, the recommended setting is between 20 and 35%. See page 6-4 to learn how 

to adjust Quality.
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Choosing an Audio Codec
CU-SeeMe uses codec software to efficiently send video and audio data across a 

network, as explained in “Choosing a Video Codec” on page 6-2. Your choice will 

depend on your computer environment, especially whether you are communicating 

using a modem, a LAN, or an ISDN line. Use Table 6-2 to choose the best audio codec 

for your computer.

Table 6-2. Audio codec recommendations

You can use this 
audio codec

If you are using this means of 
communication

Modem ISDN LAN

Voxware (2.4 Kbps) ✔ ✔ ✔

DigiTalk (8.5 Kbps) ✔ ✔ ✔

Delta-Mod (16 Kbps) ✔ ✔

Intel® DVI (32 Kbps) ✔ ✔
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As with the video codecs, previous versions of CU-SeeMe did not include all of these 

audio codecs. People using older versions of the software will not be able to receive 

audio sent with some of the newer codecs. Table 6-3 explains who can hear your audio, 

depending on your choice of audio codec.

The DigiTalk and Voxware audio codecs both work well with low bandwidths and 

therefore are usable with most modems. The DigiTalk codec is able to transmit both 

voice and music, whereas the Voxware codec is able to send voice only. Although the 

Delta-Mod and Intel® DVI codecs can both be heard by any CU-SeeMe user, they 

require large amounts of bandwidth (Delta-Mod requires the most bandwidth), and 

therefore may slow the overall performance of CU-SeeMe.

Sending audio and video simultaneously takes a large amount of bandwidth. If you are 

using a low bandwidth connection, such as a modem, you can freeze your local video 

window to increase the amount of bandwidth available for sending audio. To do this, 

right-click on your local video window. Then click Freeze Video. A ✓ appears, 

indicating that your video is frozen. Click it again when you want to return to sending 

full-motion video.

Table 6-3. Determining who can hear your audio

If you are using this 
codec

These users will be able to see hear your 
audio

Voxware (2.4 Kbps) Any user with CU-SeeMe V3.0 or Enhanced 
CU-SeeMe V2.0 or higher (Windows 95 and NT 
users only)

DigiTalk (8.5 Kbps) Any user with CU-SeeMe V3.0 or Enhanced 
CU-SeeMe V2.0 or higher (Windows users only)

Delta-Mod (16 Kbps) Any user with any version of CU-SeeMe 
(including Cornell freeware) and Enhanced 
CU-SeeMe

Intel® DVI (32 Kbps) Any user with any version of CU-SeeMe 
(including Cornell freeware) and Enhanced 
CU-SeeMe
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To choose an audio codec:

1. Click the Customize button on the Conference Room toolbar. Point to 
Configuration, then click. The Customize dialog box appears (with the 
Configuration tab displayed), as shown in Figure 6-4.

Figure 6-4. You can select an audio codec

2. The audio codec section is presented in the upper portion of the dialog box. Move 
the audio codec slider to select an audio codec. Note that moving the slider to the 
right improves the quality of the audio you send, but it also decreases performance 
of your computer. Moving the slider to the left increases performance but lowers 
the quality. A lower quality audio codec will work better with a lower bandwidth 
network connection, such as a modem. See “Choosing an Audio Codec” on page 
6-9 for information to help you select an audio codec. 

3. Select the Hands Free Operation check box if you have a full-duplex sound card. 
If you select Hands Free, you will also see a check box labeled Use Echo 
Reduction. When you are receiving audio and sending audio simultaneously, the 
echo reduction control can prevent your microphone from sending sound that is 
coming from your speakers. This will eliminate feedback, which can occur if your 
microphone is placed near your speakers. Select this check box to use echo 
reduction. When echo reduction is selected, (and you have clicked OK or Apply), 
you will see red and green triangle sliders above the microphone indicator in the 
audio control section of the Conference Room Window. To learn how to use these 
sliders and to learn more about Hands Free mode, see “Using Your Microphone 
in Hands Free Mode” on page 4-31.
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4. Select the High Mode check box if you are sending audio over a high loss 
network. High mode adds more redundant audio data across the network which 
helps your audio to be clearer even if some data is lost. High mode also causes 
your audio to be delayed several seconds.

5. Click OK when done.
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Test Your Setup
The best way to adjust your video and audio settings is using the Test Setup feature. 

To use this, click the Test Setup button on the Phone Book toolbar. The Test Setup 

dialog box appears, as shown in Figure 6-5.

Figure 6-5. Test Setup dialog box allows you to easily configure your video and audio

The Test Setup dialog box has two tabs, one for testing video and the other for testing 

audio. 

This is your local
video image

This is your remote video,
as others will see you
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Testing Video
The Test Video tab is shown in Figure 6-5. If you have a video camera and it is 

connected and configured correctly, you will see two video images of yourself. The 

one on the left is your local video and the one on the right is your remote video image. 

The remote video image shows how others will see you in a conference. The remote 

video image is helpful because you can change codec settings and see how it affects 

the video that you send. 

To change video codec settings:

1. Click the arrow next to the video codec to display a list of available codecs. Click 
on the name of the desired codec.

2. Click Configure. Some codecs allow you to make additional configuration 
settings and other codecs do not. For example, you cannot change configuration 
settings for White Pine M-JPEG and White Pine H.263 codecs.

3. The compression adjustment slider is preset for each codec; however, you can 
adjust it manually. Note that moving the slider to the right improves the quality of 
the image you send, but it also decreases performance of your computer. Moving 
the slider to the left increases performance but lowers the quality. Lowering the 
quality setting sends a lower quality video image and sends less data. Therefore, 
a lower quality setting will work better with a lower bandwidth network 
connection, such as a modem.

Higher quality settings use more bandwidth and cause a longer time delay in your 
video picture.You can observe this by setting your quality to a high setting, 
viewing both your local video and remote video simultaneously, and then waving 
your hand in front of the video camera. The higher the quality setting, the more 
time delay there is between when you move your hand and when the movement 
is shown in the remote video window. You will see that the quality setting does 
not affect your local video window. Choose the lowest quality setting that 
provides an acceptable remote video image. If you are using a modem, you will 
need to use a lower quality setting than if you are using LAN or WAN.

4. Click the arrow next to the capture device to display a list of video capture devices 
installed in your computer. Click on the name of the desired device.

5. Click Format or Source to make additional settings adjustments.

6. Click OK when done.
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Testing Audio
If you have a microphone, speaker, and sound card, you can test and adjust your audio 

settings using the Test Setup feature.

To change audio settings:

1. Click the Test Setup button on the Phone Book toolbar. The Test Setup dialog 
box appears. Click on the Test Audio tab. The Test Audio tab is shown in Figure 
6-6.

Figure 6-6. Test your audio setup

2. Move the audio codec slider to select an audio codec. Note that moving the slider 
to the right improves the quality of the audio you send, but it also decreases 
performance of your computer. Moving the slider to the left increases 
performance but lowers the quality. A lower quality audio codec will work better 
with a lower bandwidth network connection, such as a modem. See “Choosing an 
Audio Codec” on page 6-9 for information to help you select an audio codec. 

Audio codec slider

Select this if you have
a full duplex sound card
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3. Select the Hands Free check box if you have a full-duplex sound card. (To learn 
more about Hands Free mode, see “Using Your Microphone in Hands Free Mode” 
on page 4-31.) If you are in Hands Free mode, you will see the Squelch slider. The 
Squelch control is only displayed when you are in Hands Free mode. This control 
sets the minimum level for sound to be sent from your microphone when you are 
not receiving audio. Any sound below this level will not be transmitted. Drag the 
Squelch slider to the right to raise the minimum level of sound that you will 
transmit. This can be useful when there is background noise in your environment. 
You can adjust the squelch level so that the background noise is not transmitted. 

4. Speak into your microphone to test the volume level. Move the microphone 
volume slider to raise or lower the level.

5. Click the arrow next to the recording device to display a list of audio recording 
devices installed in your computer. Click on the name of the desired device.

6. Click Test to play a sound sample. Move the speaker volume slider to raise or 
lower the sound level.

7. Click the arrow next to the playback device to display a list of audio playback 
devices installed in your computer. Click on the name of the desired device.

8. Click OK when done.
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Setting Transmission and Reception Rates
For best performance you may need to adjust the rate at which you send and receive 

video and audio signals. Table 6-4 shows general guidelines for setting maximum 

transmission and reception rates.

CU-SeeMe selects 80 Kbps as the default transmission rate. If you are on a LAN or 

have a connection with higher bandwidth, you can increase this rate for better 

performance. However, if you are transmitting with a 28.8 Kbps modem, you will be 

limited to a transmission rate of 28 Kbps and you should adjust your rate accordingly.

The reception options set the rate at which you receive audio and video. Limiting 

reception may be important if you have a 28.8 Kbps modem connection. If you are set 

to receive 30 Kbps for example, you may not be able to send any signals out because 

you will be using all of your available bandwidth to receive signals.

When you join a group conference, you may find that some conferences will not admit 

you until you make adjustments in your transmission and receptions rates. Other 

conferences may ask you if you would like to have your rates adjusted automatically. 

You can choose this automatic adjustment option if it is presented to you.

Setting Rates for a Contact Card
You can set minimum and maximum transmission and reception rates for each entry 

in your Phone Book using the Contact Card Editor. This is useful because some 

conference servers require lower transmission rates than others and you can preset 

your rates for each conference server individually by editing the Contact Card in the 

Phone Book.

Table 6-4. Suggested transmission and reception rates

When using Set transmission and reception rates to

Modem Match the speed of your modem, such as 28 
Kbps or 33 Kbps

ISDN 40 Kbps or higher, depending on the properties of 
your ISDN line

LAN 80 Kbps or higher, depending on the 
configuration of your LAN
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To set transmission and reception rates using the Contact Card Editor:

1. Select the entry in the Contact Card list by clicking on a Contact Card or a name 
in the list of Contact Cards.

2. On the Edit menu, click Contact Card Properties. The Contact Card Editor 
appears. Select the Network tab as shown in Figure 6-7.

Figure 6-7. The Contact Card Editor lets you modify transmission and reception rates

3. Change the maximum transmission and reception rates by clicking on the arrows 
or typing a new rate in the text boxes (see Figure 6-7). 

4. Change the minimum transmission and reception rates by typing in the text boxes 
(see Figure 6-7).

5. When you have completed all your edits to the Contact Card, click OK. These 
changes will be saved in your Contact Card. Any time you connect to the person 
or place on that Contact Card, you will use these new settings.

Select this to 
modify settings

Enter maximum
transmission rate
(Kbps)

Enter maximum
reception rate
(Kbps)

Select this to send
video when connected

Select this to use the
settings defined in your
Personal Profile

Enter minimum
reception rate
(Kbps)

Enter minimum 
transmission rate
(Kbps)

Select this to use the
minimum reception
and transmission rates
you define
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Setting Rates While In a Conference
In addition to setting rates for each Contact Card, you can also change your maximum 

transmission and reception rates while you are in a conference. This change will affect 

the current connection only.

To set transmission and reception rates in a conference:

1. Click the Customize button on the Conference Room toolbar. Point to 
Hardware, then click. The Customize dialog box appears (with the Hardware tab 
displayed), as shown in Figure 6-8.

Figure 6-8. You can change transmission and reception rates while in a conference

2. Change the maximum transmission and reception rates by clicking on the arrows 
or typing a new rate in the text boxes (see Figure 6-8). Note that you cannot 
change the minimum rates while you are connected. To change minimum rates, 
you must hang up from the conference and change the rates using the Contact 
Card Editor. For more information, see “To set transmission and reception rates 
using the Contact Card Editor:” on page 6-18.

3. When you have completed your changes, click OK.

Select this to 
modify settings

Enter maximum
transmission rate
(Kbps)

Enter maximum
reception rate
(Kbps)
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Setting Rates for a Personal Profile
You can set maximum transmission and reception rates for each Personal Profile that 

is stored in your Phone Book. For example, if you have a portable computer that uses 

a LAN from your office and a modem from your home, you would want to have two 

different sets of maximum transmission and reception rates, one for each location. In 

this instance, you would define one Personal Profile to use from your office and 

another to use from your home. Each profile would have rates defined for the specific 

network type.

To set transmission and reception rates for a Personal Profile:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed).

3. Select a Profile from the list. Then click Edit.

4. The Personal Profile Editor appears. Select the Hardware tab, as shown in 
Figure 6-9.

Figure 6-9. Select a network configuration in the Personal Profile Editor

Click here to display
a drop-down list from 
which you can select your
type of network

Click here to 
display the
Customize Network
dialog box
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5. In the Network Configuration section, use the drop-down list to select the network 
type that most closely matches yours. Then click Customize.

6. The Customize Network dialog box appears, as shown in Figure 6-10.

Figure 6-10. You can modify minimum and maximum transmission and reception rates

7. Change the maximum transmission and reception rates by clicking on the arrows 
or typing a new rate in the text boxes (see Figure 6-10). Note that you cannot 
change the minimum rates for a Personal Profile. To change minimum rates, you 
must change the rates using the Contact Card Editor. For more information, see 
“To set transmission and reception rates using the Contact Card Editor:” on page 
6-18.

8. Click OK. 

9. When you have completed all your edits to the Personal Profile, click OK.

10. Then click OK again to close the CU-SeeMe Call Options dialog box.

Enter maximum
transmission rate
(Kbps)

Enter maximum
reception rate
(Kbps)
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Registering With an Online Directory Service
A directory service is a Web-based listing that allows users of CU-SeeMe to find each 

other, see if they are online, and connect directly to them. 

Each user on the Internet has an Internet Protocol (IP) address that is a unique 

identifier. Many Internet Service Providers and online services assign IP address 

dynamically; that is, you get a new IP address each time you connect to the Internet. 

This is like changing your telephone number each time you place a call, and it has 

made it difficult in the past for online users to find and connect to each other. The 

Web-based directory service solves this problem by automatically registering your 

current IP address as soon as you connect to the Internet, making it easy for other 

people to locate you.

When you set up CU-SeeMe on your computer, you were given the opportunity to 

register with Four11 directory service (see “Using the Setup Assistant” on page 2-2). 

If you chose this option, you are now listed in this Web-based directory and other 

CU-SeeMe users will be able to locate you online. If you did not choose this 

registration option during set up, you can still register at any time.

To register with Four11 directory service:

◆ From the Windows desktop, click Start, point to Programs, point to CU-SeeMe, 
then click Four11 Registration. Your Web browser will open and you will be 
connected to the Four-11 CU-SeeMe registration page.

- or - 

◆ Using a Web browser, go to the Four11 Web page at http://www.four11.com.
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Appendix A
Technical Support

This Appendix contains information on how to contact White Pine for technical 

support and sales information.
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Getting Technical Support
White Pine Software provides telephone support to all registered users after registering 

the product. Only purchased copies of the product can be registered, meaning that you 

can not register any of the freeware versions of CU-SeeMe available through Cornell 

University. 

Registering CU-SeeMe
You must register with White Pine in order to receive technical support. You can 

register in any of the following ways:

◆ Complete the registration card included with CU-SeeMe and mail it to White Pine.

◆ From the Help menu in CU-SeeMe, click Registration. This opens a Web browser 
and displays the White Pine Software Product Registration Web page, allowing 
you to register your copy of CU-SeeMe online. 

◆ Using any Web browser, go to the CU-SeeMe Web page at 
http://www.cuseeme.com and select Register Software. Fill out the online form 
to register your copy of CU-SeeMe.

Support on the World Wide Web
The White Pine Web pages offer a variety of information about the company, products, 

and demo versions of released software, in addition to technical support.

The Technical Support pages offer online registration, technical support through an 

interactive form, and a list of Frequently Asked Questions about using CU-SeeMe.

You can reach the White Pine Software technical support Web page at 

http://www.cuseeme.com/support.

Support Through E-Mail
White Pine’s technical support staff also answers questions through e-mail. In your 

e-mail message, be sure to include your name, company name (if applicable) and 

phone number so that the technical support staff can contact you to meet your support 

needs.
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Before You Contact Technical Support
White Pine Software provides technical support to registered users. Return your user 

registration card promptly or register CU-SeeMe using online registration (see 

“Registering CU-SeeMe” on page A-2). Product registration guarantees you new 

product notification and product upgrades.

To get your problems solved as quickly as possible, the technical support staff requires 

as much pertinent information as possible. If you can supply us with this information 

at the time of your call, we can understand and resolve your problem much faster. You 

should have this information ready and be at your computer when you call for technical 

support and be ready to reproduce the problem while talking to a technical support staff 

member.

Please fill out the following information before calling:

Serial #:

Product:

Version:

Date Purchased:

Original Purchaser:
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Your Computer Configuration
Make and Model: 

DOS Type and Version: 

Microsoft Windows Version: 

Disk Space: 

Memory (RAM): 

Video Card Manufacturer and Model: 

Video Capture Card Manufacturer and Model: 

Sound Card Manufacturer and Model: 

Camera Manufacturer and Model: 

Microphone Manufacturer and Model: 

Contents of the following files:

◆ Network configuration files, if applicable (for example, TCP.CFG or NET.CFG)

◆ WIN.INI

◆ SYSTEM.INI

◆ AUTOEXEC.BAT

◆ CONFIG.SYS
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Communications Configuration
Internet Connection:

Ethernet:        ISDN:         Modem:

Modem Manufacturer and Model:

Model of your Ethernet board:

Network drivers and other communication software installed on your system:

◆ TCP/IP Driver:

◆ Dial-up PPP (if using a modem):

◆ Internet Service Provider (ISP): 
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Contacting White Pine Software
While our Technical Support staff often takes calls immediately, there are times when 

a representative may be unavailable. If your problem can not be resolved during your 

initial call, the issue will be discussed with our product specialists and engineering 

staff, and a representative will contact you.

Technical Support
E-mail: cusupport@wpine.com

Phone: 603-594-2804 8:00 am - 8:00 pm EST

408-446-9203 8:00 am - 8:00 pm PST 

Corporate Headquarters
White Pine Software, Inc.

542 Amherst Street

Nashua, NH 03063 USA

Phone: 603-886-9050

Fax: 603-886-9051

E-mail: info@wpine.com

WWW: http://www.wpine.com 

West Coast Office
White Pine Software, Inc.

1485 Saratoga Avenue

San Jose, CA 95129-4934 USA

Phone: 408-446-1919

Fax: 408-446-0666

E-mail: info@wpine.com 
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European Headquarters
White Pine Software, SA

9551, route de Saint Laurent du Var

06610 La Gaude France

Phone: +33.4.93.59.43.43

Fax: +33.4.93.24.76.06

E-mail: euro-info@whitepine.fr 

Sales Hot Line
For more information about all White Pine Software products, please contact the White 

Pine Software sales department. Demos and product information are also available on 

the World Wide Web. 

U.S. E-Mail:  info@wpine.com

U.S. Phone:  1-800-241-PINE (7463)

Europe E-Mail:  euro-info@whitepine.fr

Europe Phone:  +33.4.93.59.43.43

WWW: http://www.cuseeme.com
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Glossary

Bandwidth

The capacity to send information on a network. It is usually measured in 

bits per second (bps) or kilobits per second (Kbps).

Browser

A software program that allows a user to access resources on the Internet. 

Chat Macro

Shortcut buttons that allow you to automate typing of words, phrases, or 

symbols that you use often.

Chat Window

A feature of CU-SeeMe that allows users to converse using text 

messages. The Chat window is a component of the CU-SeeMe 

Conference Room window.

Codec

COmpressor/DECompressor; Hardware or software that compresses and 

decompresses audio and video data. CU-SeeMe uses software codecs.

Conference ID

A number between 1 and 32768 that is provided to attendees of a private 

conference session. This ID number is needed for some conferences.

Conference Room

The CU-SeeMe window in which videoconferencing takes place. It is 

like a virtual meeting room where you can see and talk to others.
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Conference Server

Software that delivers multimedia group interaction across IP networks. A 

conference server is the server program in a client/server videoconferencing 

solution. (CU-SeeMe is the client program.)

Contact Card

A convenient tool for storing information about a person or place. It is like a 

business card or a card in a rotary file. Contact Cards are displayed in the 

CU-SeeMe Phone Book Window.

Contact Group

A collection of Contact Cards.

CU-SeeMe

Videoconferencing software for desktop computers. 

CU-SeeMe Name

Your user name that appears when you conference with others. Your 

CU-SeeMe name and the CU-SeeMe names of other participants appear in 

the Participants List in the Conference Room window.

Cybercast Conference

The transmission of the same data to a selected group of destinations.

Full-Duplex

Allows both parties to send and receive audio at the same time. This affects 

the receiver only.

Half-Duplex

Allows only one person to talk at a time. This affects the receiver only.

Internet

A global network that uses the TCP/IP protocol.

Internet Service Provider

A company that provides a connection to the Internet for a fee.
G-2     CU-See Me User Guide



IP Address

The unique numeric address for every computer that is connected to the 

Internet. It has four sections separated by a dot, for example, 100.1.1.1. An IP 

address can be dynamic and is often provided by Internet service providers.

IP Name

The unique name for every computer that is connected to the Internet. 

ISDN

Integrated Services Digital Network; A high bandwidth network used to 

move large amounts of data over phone lines.

Kbps 

An abbreviation meaning kilobits per second, used for measuring bandwidth.

Listener

A CU-SeeMe feature that alerts you to an incoming call.

Local Area Network (LAN)

A network made up of two or more computers connected together. They are 

usually within the same building or within a very short distance (a mile or 

less) to each other.

Local Video

The window containing your video image on your computer screen. This 

video image can be sent to other people using CU-SeeMe.

Lurker

A CU-SeeMe conference participant who is not sending a video image.

Message of the Day (MOTD)

A dialog box that appears when users connect to a conference. It can provide 

information about the conference, current and upcoming cybercasts, etc.

Multicast

The ability to send one stream of video data and one stream of audio data over 

a network, and many users can simultaneously connect to and receive these 

streams of data without the use of additional software. 
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Parental Control

A security feature that allows you to put restrictions on the CU-SeeMe calls 

that are made from your computer and the calls accepted by your computer.

Participants List

A component of the Conference Room window that lists the people currently 

connected to a conference.

Personal Profile

A Personal Profile identifies you to other people on the network. It includes 

your CU-SeeMe name, contact information, Parental Control options, and 

more.

Phone Book

A CU-SeeMe feature that works like a personal directory where you can list 

anyone you might want to call. You use the Phone Book to initiate a 

CU-SeeMe videoconference call.

Point-to-Point Conference

A direct connection between two CU-SeeMe users.

PPP

Point-to-Point Protocol. A protocol that allows a computer to make a TCP/IP 

connection using a telephone line and a modem.

Profile Contact Card

When you create a Personal Profile, you also create a Profile Contact Card. It 

is like a business card that you can exchange with others electronically.

Protocol

Standards that allow programs on different computers to communicate.

Remote Video 

The window that contains the video sent by another participant in a 

conference.
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Router

A computer system or software package that connects two or more networks. 

Routers look at the destination addresses of the IP packets and forward them 

to the correct address.

Sender

A CU-SeeMe conference participant who is sending a video image.

TCP/IP

Transmission Control Protocol/Internet Protocol. The protocol that defines 

the Internet.

Time-to-Live (TTL)

A value used by routers that is decremented as it is passed from router to 

router.

URL

Uniform Resource Locator. An “address” used to locate information on the 

Internet.

WhitePineBoard

A feature of CU-SeeMe that allows users to view, create and/or share the 

same document at the same time.

Wide Area Network (WAN)

A large network made of connected LANs.
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White Pine Software, Inc. End User License Agreement

THIS IS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF
THIS AGREEMENT.

1. White Pine grants to you a non-exclusive, non-sublicensable, license to use this Software in binary executable form.

This White Pine Software, Inc. (“White Pine”) End User License Agreement accompanies a White Pine software product
and related explanatory written materials (“Software”). The term “Software” shall also include any upgrades, modified
versions or updates of the Software licensed to you by White Pine. 

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR DOCUMENTATION, OR ANY COPY
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. White Pine reserves the right at any time to alter prices, features, specifications, capabilities, functions, licensing terms,
release dates, general availability or other characteristics of the commercial release of the software.

3. Title, ownership rights, and intellectual property rights in and to the Software shall remain in White Pine and/or its
suppliers. You agree to abide by the copyright law and all other applicable laws of the United States including, but not
limited to, export control laws. You acknowledge that the Software in source code form remains a confidential trade secret
of White Pine and/or its suppliers and therefore you agree not to modify the Software or attempt to decipher, decompile,
disassemble or reverse engineer the Software, except to the extent applicable laws specifically prohibit such restriction.

4. Copyright. The Software is owned by White Pine and its suppliers, and its structure, organization and code are the
valuable trade secrets of White Pine and its suppliers. The Software is also protected by United States Copyright Law and
International Treaty provisions. You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or
otherwise attempt to discover the source code of the Software. You may use trademarks only to identify printed output
produced by the Software, in accordance with accepted trademark practice, including identification of trademark owner’s
name. Such use of any trademark does not give you any rights of ownership in that trademark. Except as stated above,
this Agreement does not grant you any intellectual property rights in the Software.

5. White Pine may terminate this License at any time by delivering notice to you and you may terminate this License at any
time by destroying or erasing your copy of the Software. In the event of termination, the following sections of this License
will survive: 2, 3, 4, 5, and 6. This License is personal to you and you agree not to assign your rights herein. This License
shall be governed by and construed in accordance with the laws of the State of New Hampshire and, as to matters
affecting copyrights, trademarks and patents, by U.S. federal law. This License sets forth the entire agreement between
you and White Pine.

6. WHITE PINE OR ITS SUPPLIERS SHALL NOT BE LIABLE FOR (a) INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
INDIRECT DAMAGES OF ANY SORT, WHETHER ARISING IN TORT, CONTRACT OR OTHERWISE, EVEN IF WHITE
PINE HAS BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR (b) FOR ANY CLAIM BY ANY OTHER
PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO
THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME STATES DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND
EXCLUSION MAY NOT APPLY TO YOU.

7. ACKNOWLEDGEMENT: YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT,
AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN
THE PARTIES RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT.

Should you have any questions concerning this Agreement, please contact in writing:

White Pine Software, Inc., 542 Amherst Street, Nashua, NH 03063.
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